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o 1-2-3-2-1 Start F1
o 1-2-3-2-2 End F2
o 1-2-3-3 Window
o 1-2-3-3-1 Map Watch
o 1-2-3-3-2 Add Watch
o0 1-2-3-4 Setup
0 1-2-3-4-1 Chart (setup)
0 1-2-3-4-2 Monitor
o 1-2-4 Map Watcher
o 1-2-4-1 File
o 1-2-4-1-1 Open
o 1-2-4-1-2 Save As
o 1-2-4-1-3 Exit
o 1-2-4-2 Log
0 1-2-4-2-1 Start
o 1-2-4-2-2 End
o0 1-2-4-3 View
o 1-2-4-3-1 Map Trace
o 1-2-4-3-2 Ghost
o 1-2-4-3-3 Col Width
o 1-2-4-3-4 Dec. Places
0 1-2-4-4 Window
0 1-2-4-4-1 Monitor
0 1-2-4-4-2 Chart
o 1-2-4-5 Options
o 1-2-4-5-1 MapRef
0 1-2-4-6 Drop Down Channel Selector
o 1-2-4-7 Drop Down Filter
0 1-2-4-8 Hold Off (m Sec)
o 1-2-5 Add Watch
o 1-2-6 Hide Watch
o 1-3 Setu
o 1-3-1 Port Com1l ~8
o 1-3-2 Auxiliary (Setup)
o 1-3-2-1 Polynomial (Setup)
0 1-3-2-2 Delta AN1- AN2
0 1-3-2-3 Delta AN3 - AN4
o 1-3-2-4 ReCalculate Log
o 1-4 Tools
o 1-4-1 ReCalc Base
o 1-5 Read All
o 1-6 Write All
o 1-7 Update
o 1-8 Map Tracer

2- Fuel Correction Map (Injector Map)

0 2-1 Read Injection Map
0 2-2 Write Injection Map

3- Ignition Map
o 3-1 Read IGN Map
0 3-2 Write IGN Map
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4- VVT Map

0 4-1 Read VVT Map
0 4-2 Write VVT Map

5- Base Fuel Map

o0 5-1 Read Base Map
0 5-2 Write Base Map

A- Settlngs One

A-1 Boost Control
o A-2 Rev / Idle
A-2-1 Rev Limit
2 F/C A.E
3 F/C E/L
4 F/CA/C
A-2-5 Idle A.E
A-2-6 Idle E/L
7 Idle A/C
Function Select
Boost Control Kit

A-3-1

A-3-2 Injector / Air Flow Warn
A-3-3

3-

A-2-2
A-2-3
A-2-4
A-2-
A-2-
A-2-7
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Knock Warn
4 02 F/B Control
A-3-5 Idle-IG Control
Version
Knock Warning
02 Feedback
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mgs Two

Water Temp Correction
Accelerate Injector Time
Cranking Time

Injection vs. Acceleration TPS1
Injection vs. TPS

Injection vs. Air Temp
InJectlon vs. Air Temp & Load

. Water Temp & load

mgs Three

Map Reference
Air Flow

mgs Four

D 1 Ignition vs. Water Temp (cool)
D-2 Ignition vs. Water Temp

D-3 Boost vs. IGN S.F.

D-4 Ignition vs. Air Temp

D-5 Ignition vs. TPS

D-6 Ignition vs. Battery Voltage
D-7 Ignition vs. RPM
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E- Settlngs Five

E-1 Injectors
o E-2 Primary Injector lag (uS) vs. BatV
o E-3 FC-Box Custom Features
o E-3-1 Anti lag (Stutter box) ©
o E-3-2 Remote boost switch
o E-3-3 Tuner String
0 E-4 Notes

FC- FC-Box

FC1 FC-Box 4 Additional inputs
FC2 FC-Box 4 Switches
FC3 Mini din cable
FC4 Mini din Socket
FC5 Serial Socket
Connection

otes

N-1 Knock Value
N-2 Boost Control Kit for single turbo
N-3 Mac Laptop & FC-Datalogit
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-2 BOOST CUT
W-3 Exhaust Temp Light flashing!
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Z-Screen Captures
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To view the settings in two files simultaneously
How the sample chart was created, Chart tutorial

1 “"Read all” the settings and maps and save the file!

W Check Engine Light Flashing Slowly! Injector Duty / Map Warning
W-5 Check Engine Light Flashing Quickly! Knock Warning
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FC-Datalogit

> Introduction ” Back to Contents

o FC-Datalogit is a package comprised of:
» FC-Edit Software
» FC-Box Hardware
» FC-Datalogit User Group

o Key for this Manual

Title

o Description (Shot cut key) [short key (then >) short key]
> What it does
o How to use it
= Detail on how to use it
e NOTE
o Note or Function list
I Important Note
¢« DANGER!!

Questions? Manual@fc-datalogit.co.nz

¢ *An important Notice before you plug in your FC-Box {E-5-3 Tuner
String}

» FC-Datalogit CD ﬁ

o The FC-Datalogit CD
e You will receive the FC-Datalogit CD with you FC-Datalogit Package.
o The CD contains

= A PDF copy of this manual. Updated user manuals are e-mailed the
registered owners of FC-Datalogit

» FC-Edit. Updated versions are e-mailed the registered owners of FC-
Datalogit
I You must install the FC-Datalogit CD version of FC-Edit before you

can update it!

» Log folder: with a sample log

» Settings folder: with base default settings

= “setup exe”

> To install the CD version of FC-Edit

= Insert the CD into your CD ROM drive

Questions? Manual@fc-datalogit.co.nz
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= Open the CD
= Double click “setup exe”, follow the set-up instructions

»To install an updated version of FC-Edit

I You must install the FC-Datalogit CD version of FC-Edit before you
can update it!

= It will arrive as an attachment to an e-mail from FC-Datalogit.

= Right click on the attached file and choose ‘copy’

= Open the ‘FC-Edit’ folder in the ‘program files’ folder on ‘C’ drive in your
computer

» Right click anywhere in the ‘FC-Edit folder and choose ‘paste’

= You will be told “this folder already contains a file named ‘FC-Edit~.exe"”
“Would you like to replace the existing file with this one”?

= Choose ‘yes’

» FC-Datalogit user E-group ﬁ

You must purchase FC-Datalogit before you can be invited to join the FC-Datalogit
user e-group.

You must not redistribute anything from the e-group. We encourage members to
share their knowledge and redistribution put this into jeopardy.

FC-Datalogit reserves the right to remove members from the e-group at their
discretion.

To be invited e-mail the following information to;
glen@fc-datalogit.co.nz

FC-Box serial number.

FC-Edit version number.

Date and point of purchase.

The e-group is a user forum with a database and some other web tools.

The latest version of FC-Edit and this manual are kept on the e-group.

There is a section for users to post / share their setting data if they wish.

If you have any questions about FC-Datalogit or general tuning we encourage you
to post them to the e-group.

All questions are posted to all e-group members.

Likewise if you can answer a question feel free to answer. We value your input. We
have also added a section where you can make suggestions. We will include
anything reasonable and achievable.

Questions? Manual@fc-datalogit.co.nz 7
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Tonap | B ey | Serims | | Samonge 2 | S8 T Semnge 5| wenan

FC.'—E.dn 2ZZ-6E v1.081 FC- DatE

FC-Edit Software is o be used in
" conjunction with a Power FC and requires |
on "FC-Ban” interfoce,
This version of FC-Edit is for 1ZZ-FE, Pk
For mors information. and the avalving
monual, go te
hitp:/ fgreups.yohoo com//group /datalogit
E-Mail 2ZZ6E@rxTnet nz

We have foken great care fo ensure that sur products are os safe as possible_BUT. pleose
faka extreme care when using this product. Inputting incorrect data imto o POWER FC con
damoge your engine. Tf you hwe any doubts sbout this product or your ability fo e it please
DO NOT use this product.

Beod All Write All

o Refer to FC-Edit Cover page {FC-Edit}
e Main refers to the drop down menus and items placed around the
central tab area on the FC-Edit software

1-1 File

22 FC-Edit 2ZZGE - default.dat

Window Tools  Setup

De
Ope
Savehs

TGN Map | VT Map

2 [No3 [Wo4 [NDS |
0 1.0001.000 1.000
1.000 1.000/ 1.000 1.000
1.000 1.000/ 1.000 1.000
P04 |1.0001.000 1.000 1.000/1.000
P05 |1.0001.000 1.000 1.000/1.000
PO |1.0001.000 1.000 1.000/1.000
P07 |1.0001.000 1.000 1.000/1.000
POZ |1.0001.000 1.000 1.000/1.000

o Drop down File menu (Alt f)
> To access the following commands; Default, Open, SaveAs, Compare and Exit
o To open the drop down File menu, Left Click “File”, once

Compare 1

Exit

1-1-1 Default ™

E2 FC-Edit 2ZZGE - _efault.dat

Window |, T

Defaulk
Open

Savehs MOZ [NO3 [NO4 [0S |
Compare  § 00 1.000 1.000 1.000
1.000 1.000 1.000 1.000
1.000 1.000 1.000 1.000
P04 |1.000 1.000 1.000 1.000 1.000
P05 |1.0001.000 1.000 1.000 1.000
POE_|1.000/1.000 1.000 1.000 1.000
P07 |1.0001.000 1.000 1.000 1.000
P08 |1.0001.000 1.000 1.000 1.000

o Restore maps and settings to “"Default”
» Loads the file “default.dat” from FC-Edit folder in program files
o To load the file “default.dat”, Left Click “Default” in the drop down File
menu, once

Questions? Manual@fc-datalogit.co.nz 8
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e The default file is NOT the same as resetting the Power FC to Apexi
original settings with a commander.
o To make the default file the same as your Apexi Power FC original settings
» Reset your Power FC with a commander
» Save the settings with Datalogit “save as” function
» Name the file “default.dat”
o To change the data in the default file by
= Opening the default file, change the maps or settings and then save the
file as default.dat

= Or bi re-naming any other settings file “default.dat”
6 Frror coaning dal el cal

e If you get this message then you don’t have a default.dat file in your
FCEdit_3SGTE folder in your program files.
All unsaved data or unsaved changes made to the previous file will

be written over with the maps and settings in your default file
Save files or you will loose the data!

o

&

Defaulk
Open

Savehs NOZ [NO3 [NO4 [NOS |
Compare 9000 1.000 1.000 1.000
1.000 1.000 1.000 1.000
1.000 1.000 1.000 1.000
P04 |1.0001.000 1.000 1.000 1.000
P05 |1.0001.000 1.000 1.000 1.000
P0G |1.0001.000 1.000 1.000 1.000
P07 |1.0001.000 1.000 1.000 1.000
PO& |1.000/1.000 1.000 1.000 1.000

o Open an existing File (Alt o) [Alt f > Alt o > left click to choose file > Alt 0]
» To Open an existing file
o To Open a existing file, Left Click "Open” in the drop down File menu, once
= “Open” window will appear
» Locate the file you wish to open
= Double left click the file you wish to open
= OR left click the file and left click the open button
¢ All unsaved data or unsaved changes made to the previous file will
be written over
¢ Save files or you will loose the datal!

GMhap | WUT mhap

Exit

1-1-3 SaveAs

Questions? Manual@fc-datalogit.co.nz 9
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22 FC-Edit 2ZZGE - default.dat

Window  Toals
Defaulk
Open

Savehs MOZ [NO3 [NO4 [0S |
Compare  § 00 1.000 1.000 1.000
1.000 1.000 1.000 1.000
1.000 1.000 1.000 1.000
P04 |1.000 1.000 1.000 1.000 1.000
P05 |1.0001.000 1.000 1.000 1.000
POE_|1.000/1.000 1.000 1.000 1.000
P07 |1.0001.000 1.000 1.000 1.000
P08 |1.0001.000 1.000 1.000 1.000

o Save a File (Alt a) [Alt f > Alt a > Alt n (hame the file) > Alt s]
» To Save a file
o To Save a file, Left Click “"SaveAs” in the drop down File menu, once

= “Save As” window will appear

= Left click in the “File name” box and give the file a unique name

= OR, left click on an existing file

= Left click on the “Save” button

¢ If you choose to save a file using an existing file name, the original
file will be written over

0 inap | T wap

Exit

1-1-4 Compare

% FC-Edit 2ZZGE - default.dat

Windaow  Taoals

Setup

Defaulk

Open

5avehs 2 [NO3 [NO4 [NOS |
Compare %5000 1.000 1.000 1.000
Euit .000/ 1.0001.000 1.000

000} 1.0001.000 1.000
FoO4 (1.000 1.0001.000 1.000) 1.000
FOS (1.000 1.0001.000 1.000) 1.000
FOE (1.000 1.000 1.000 1.000) 1.000
FO7 (1.000 1.000 1.000 1.000) 1.000
FOS3 {1.000 1.0001.000 1.000) 1.000

o This unique tool is used to compare two files of settings to see if any values are
different (Alt c) [Alt f > Alt ¢ > left click to choose file > Alt 0]
» To Compare a file you are working on to another file
o Save the file you are working on.
Click "Compare” in the drop down File menu, once
“Open” window will appear
Locate the file you wish to Compare with the file you already have open
Double left click the file you wish to Compare
OR left click the file and left click the open button
e The difference between the two files will be displayed in all setting
and map windows
e Settings with a positive (+) difference to the file you chose to
compare to will be highlighted in red
e Settings with a negative (-) difference to the file you chose to
compare to will be

O O O O O

Questions? Manual@fc-datalogit.co.nz 10
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e {T-13} To view the settings in two files simultaneously

- /\
1-1-5 Exit
E% FC-Edit 27ZGE - default.dat

Window  Tools

Setup

Defaulk

open TGN thap | WY hiap

SavEAS MO3 [MO4 [NOS

Compare 000 1.000 1,000 1.000

Eit 1.000 1.000 1.000 1.000
1.000 1.000 1.000 1.000

FO4 {1.000 1.000 1.000 1.000) 1.000
FO5 {1.000 1.000 1.000) 1.000) 1.000
POE {1.000 1.000 1.000 1.000) 1.000
FO7 {1.000 1.000 1.000) 1.000) 1.000
FO2 {1.000 1.000 1.000 1.000) 1.000

o Shut down FC Edit program (Alt x)
» To close FC Edit program
o To Close FC Edit, Left Click “Exit” in the drop down File menu, once
¢ All unsaved data or unsaved changes made to the previous file will
be lost

¢ Save files or you will loose the data!

1-2 Window ﬁ

% FC-Edit 2ZZGE - default. dat

Window Setup

o Manitor
Graph
Chart

MapWatch  jag'1.0od 1.000
fdd Watch gg 1333 1333
Hide ‘Wwatchs : .

. 00 1.000 1.000
05 |1.000)1.000)1.000 1.000 1.000
06 |1.000)1.000)1.000 1.000 1.000
FO7 (1.000 1.000 1.000) 1.000) 1.000
FOS (1.000 1.000 1.000 1.000) 1.000

o Drop down Window menu (Alt w)
» To access the following windows; Monitor, Graph, Chart, Map Watch, Add
Watch and Hide Watches
o To open the drop down Window menu, Left Click *"Window"”, once

T|o|o|o|olo|

1-2-1 Monitor Window (FC-Datalogit) ﬁ

Questions? Manual@fc-datalogit.co.nz
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% FC-Edit 2ZZGE - defo’ .. dat

TR p | WThap_
! iaraph P P
[ Chart G |N04_[NO5 |

Map Watch 00 1.000 1,000
Add wakch gg 1333 lggg
Hide YWwatchs : .

L 00 1.000 1.000
05 |1.000)1.000)1.000 1.000 1.000
0E |1.000)1.000)1.000 1.000 1.000
FO7 (1.000 1.000 1.000) 1.000) 1.000
FO2 {1.000 1.000 1.000 1.000) 1.000

o|o|olololol

o Monitor Window (Alt m) [Alt w > Alt m]
» Monitor Window displays the various streams of data that can be logged
o To open the Monitor window Click *Monitor” in the drop down Window
menu, once

Click for Screen capture {Monitor Window }
e The streams of data are organized in separate Zones
e One or a combination of Zones can be logged

1-2-1-1 Basic Zone >
Bazic
[ ﬁlﬁ—Inj Buty
I— I—IgnTmng
I— I—ﬂ.ir Flona
I— I—Eng Rz
I— I—Speed
I— I—Bl:u:ust
I— I—Knuck
I— I—W’rrTemp
I— I—ﬂ.irTemp
[ | Batwalt

o Basic general data Zone
> A Zone on the Monitor Window that displays general data available for logging
o To select data streaming in the Basic Zone of the Monitor Window for
logging Check the “Basic” check box in the Datalogit Zone on the Monitor
Window

Questions? Manual@fc-datalogit.co.nz 12
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Latalogit

[v Basic

[ Sensors!

[ Aux ASD
[ AMap Ref

[ Advaneed

o Lines

OO0OO0OO0OO0OO0OO0OO0OO0OOo

There are two boxes for each Data value; Live on the left and Max on

the right

The following Data is displayed in the Basic Zone of the Monitor

Window;
[ ]

Inj Duty; Injector Duty time

IGN Tmng; Ignition Timing

Air Flow

Eng Rev; Rpm

Speed

Boost

Knock {N-2 Knock Value}

Wtr Temp; Water Temp

Air Temp; Manifold inlet Air Temp
Bat Volt

1-2-1-2 Sensors Zone

Senzars

I8N T owRN | YTA

[ sTR [ kL
[ aswl Fpe
[ mars [ wsy
[ Al [ Ack
[ ELL [ RPS
[ pRE | 0OzH
[ rL I FARM

[ wTRT
[ ATRT
[ ozs
[ R
[ Eb
[ akc
| A

o Sensors Zone

» A Zone on the Monitor Window that displays the status or value of various
sensors which are available for logging
o To select data streaming in the Sensor Zone of the Monitor Window for

logging, check the “Sensor” check box in the Datalogit Zone on the Monitor
Window

batalagit
[ Basic
v Sensors!
[ Aux ASD
[ Map Ref

[ Advanced

] Lines

Questions? Manual@fc-datalogit.co.nz
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e The status of the following sensors is displayed in the Sensor Zone of

the Monitor Window;

IGN

STR; Starter Switch

osw

PWS; Power Steering Oil Pressure Switch
A/C; Air Conditioner Switch

ELD; Electric Load Switch

PRE

RL

WRN

MRL

FPC

VSV

ACR

RPG

O2H

FAN

The value of the following sensors is displayed in the Sensor Zone of
the Monitor Window;

PIM; Pressure Sensor (Map sensor)
VTA; Throttle Position Sensor
WTRT; Water Temp Sensor

AIRT; Intake Air Temp Sensor
02S; Stock 02 Sensor

NRM

ELD

A/C

AE

® OO O0OO0OO0OO0DO0OO0OO0OO0O0O0OO0OO0OO0OO0OOo

O O0OO0OO0OO0OO0OO0OO0OOo

1-2-1-3 Auxiliary AD Zone N

Auxilary Al

[ amt
[ anz
[ ang
[ ang

o Additional input Zone
» Provision has been made on the {FC1 FC-Box 4 Additional inputs} for up to
four additional inputs. Their values are displayed in the Auxiliary AD Zone on
the Monitor Window and can be logged
o To select data streaming in the Auxiliary AD Zone of the Monitor Window
for logging, check the “Aux a/d” check box in the Datalogit Zone on the
Monitor Window

Datalagit
[ Basic
[ Sensors

[ Advanced
] Lines

e There are 4 additional input posts on the FC-Box, they are marked
o ADO
o AD1

Questions? Manual@fc-datalogit.co.nz 14
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AD2
AD3

(o}

(o}

¢ Voltage must be between 0~5 volts

e Possible additional inputs;

o0 Wide band 02 sensor. UEGO

e See section {E-3 FC-Box Custom Features} for more information
e {1-3-2 Auxiliary (set up)} set up scale and values for A/d

1-2-1-4 Map Position Zone N
Map Ref -
M p
]
o Map Position Zone
» Shows the current map position by displaying the values of “"P” (P01~P20)
and “"N” (NO1~N20), which can be logged
o To select data streaming in the Map Position Zone of the Monitor Window

for logging, check the "Map” check box in the Datalogit Zone on the

Monitor Window
Datalogit
[ Bosic
[ Senszors
[ Aux ASD
v Aap Ref
[ Advanced

] Lines

e The values for "P” and “"N” can be rescaled, see section {C-1 Map
Reference} for more information

e PO1~P20 {N-3 Pressure Value} in the Fuel and Ign Maps

e NO1~N20; RPM.

1-2-1-5 Advanced Zone N

Advanced

[ Rem | IGM [ Knock [

T PM [ Dwel [ Baw [ 77

[ A&FLY | Boost | Speed

[owTay [ Dwy [

[ Mims [ wHT [ 0251

N [ AT [ D252

o Advanced Zone

» A Zone on the Monitor Window that displays data useful for tuning and
available for logging
o To select data streaming in the Advanced Zone of the Monitor Window for

logging Check the “Advanced” check box in the Datalogit Zone on the
Monitor Window

Questions? Manual@fc-datalogit.co.nz 15
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Latalaogit

[ EBasic

[ Senszors
[ Aux ASD
[ Ahap Ref
v Advanced

] Lines

OO0OO0O00O00O0O0O0OO0ODO0OO0OOO0O0OO0OO0OOO

The following Data is displayed in the Advanced Zone of the Monitor

Window;

RPM

PIM; Pressure Sensor (Map sensor) (0~24000 boost)
AFL V

VTAV

INJ ms

INJ +/-

IGN

Dwell

Boost

Duty; Wastgate solenoid duty cycle

WtrT; Water Temp Sensor

AirT; Intake Air Temp Sensor

Knock; {N-2 Knock Value}

BatV

Speed

???; Don’t know what this one is ©.

02S; Stock 02 Sensor 1

02S; Stock O2 Sensor 2

???; Don’t know what this is either. Unused?
???; Don’t know what this is either. Unused?

1-2-1-6 FC-Datalogit Zone

Catalogit

[v Bosic

[v Sensors
[v Aux ASD
v Map Ref
W Advanced

] Lines

o Datalogging Zone

» The area on the Monitor Window that displays which data zones have been

chosen to be logged

o To select which Zone on the Monitor Window you want to log, check the

appropriate check box on the Monitor Window. You can choose one, any or
all Zones
The following Zones of Data on the Monitor Window are available for

O O0OO0OO0oOo

logging;

Basic Zone

Sensors Zone

Aux A/D Zone

Map Zone

Advanced Zone (Shown checked in the image above)

1-2-1-7 Lines (Logged) ﬁ

Questions? Manual@fc-datalogit.co.nz
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] Lines
o ‘“lines” in the Datalogit Zone
> Shows the number of lines of data that were logged in the last logging session
e The data, if viewed as a text file, is collected line by line
e Each line has one value for each item logged, separated by a “Tab”

e If you get 30 logs per second you will get 30 lines for each second
logged

o Different versions of Power FC will log at different rates.
e More zones logged gives less lines per second due to the speed limit
at which data can be extracted from the Power FC

1-2-1-8 Reset
Reset

Start
End

Save

o Reset values on Monitor Window (Alt r)
» Used to reset the maximum values in the Monitor Zone. Resets all values on
the Monitor Window and discards the current log file
o Left Click the “"Reset” button on the Monitor Window, once
¢ There is no auto save so Resetting will delete the current log file
¢ Save files or you will loose the datal!

1-2-1-9 Start

Reset

Start
End \

Save

o Start Logging (Alt s)
» Starts logging the selected Zones
o Left Click the “Start” button on the Monitor Window, once
¢ There is no auto save so “Start” will delete the previous log file
¢ Save files or you will loose the data!

1-2-1-10 End

Questions? Manual@fc-datalogit.co.nz 17



FC-Datalogit FD3S User Manual

Reset
Start
End

Save \

o Stop Logging (Alt e)
» Stops logging of the selected Zones
o Left Click the “End” button on the Monitor Window, once
¢ There is no auto save. “"End” will only stop the current logging. The
file created will remain until you Reset or Start a new log
Save the file as soon as possible
Save files or you will loose the data!

o Xo

1-2-1-11 Save (Alt a)
Reset

Start
End

Save

o Save log file
» Saves the log file you have just created

o Left Click the “Save” button on the Monitor Window, once
= “Save As” window will appear

» Left click in the “File name” box and give the file a unique name
» OR, left click on an existing file
= Left click on the “Save” button

¢ If you choose to save a file using an existing file name, the original
file will be written over

1-2-2 Graph ™

% FC-Edit 2ZZGE - defar’;.dat

UIEEEN Tools  Sgiffp
Marikar

: p [ T Map
Chart G |N04_[NO5 |

F|  Maptatch 00 1.000 1.000
% add atch 00 1.000 1.000
E

. 00 1.000 1.000

| HideWatchs L1000 1.000
FO5 |1.0001.000 1.000 1.000 1,000
FOE |1.000 1.000 1.000 1,000 1.000
FO7 |1.000 1.000 1.000 1.000 1,000
F02 |1.000 1.000 1.000 1.000 1.000

o Graphical representation of Maps (Alt g) [Alt w > Alt g]
» Shows graphs of the following maps; INJ, Ign, IGT, VVT, Base INJ

Questions? Manual@fc-datalogit.co.nz
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o To open the Graph Window Click “Graph” in the drop down Window menu,
once
e You can resize the Graphs by dragging the graph window

Click for Screen Capture {INJ}
o Graphical representation of the Injector correction map [Alt w > Alt g > choose
“INJ” from the drop down list]
» Shows a graph of the Injector correction map
o To View the graph of the Injector correction map, choose “INJ]” from the
drop down list on the Graph Window

2% 3D View

Click for Screen Capture {IGN}
o0 Graphical representation of the Leading Ignition map [Alt w > Alt g > choose
“IGN” from the drop down list]
» Shows a graph of the Leading Ignition map
o To View the graph of the Injector correction map, choose “IGN” from the
drop down list on the Graph Window

E2 3D View
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1-2-2-3 IGT

Click for Screen Capture {IGT}

o]
o Graphical representation of the Trailing Ignition map [Alt w > Alt g > choose
“IGT” from the drop down list]
» Shows a graph of the Trailing Ignition map
o To View the graph of the Trailing Ignition map, choose “IGT” from the drop
down list on the Graph Window

Click for Screen Capture {VVT}
o Graphical representation of the VVT map [Alt w > Alt g > choose “VVT"” from the
drop down list]
» Shows a graph of the VVT map
o To View the graph of the VVT map, choose “VVT” from the drop down list
on the Graph Window

B4 3D View

1-2-2-5 Base
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Click for Screen Capture {Base}

o Graphical representation of the Base Injector map [Alt w > Alt g > choose “Base”
from the drop down list]

» Shows a graph of Base Injector map

o To View the graph of the Base Injector map, choose “"Base” from the drop
down list on the Graph Window

B2 3D View

Manitor
iraph

Chart 5 [NO4 [NOS |

P MapWatch  og 1,000 1.000
g fwesh  Bo e
p. HideWatchs o0 1000 1.000
POS [1.000 1.000 1.000 1.000 1.000
POE [1.000 1.000 1.000 1.000 1.000
PO7 [1.000 1.000 1.000 1.000 1.000

POS |1.00011.000/1.0001.000 1.000Click for Screen Capture {FC-Datalogit Chart window
Standard and a set-up chart with watches}

o Live Chart plotter (Alt ¢) [Alt w > Alt c]

e GMS Strip Chart by “Global Magic Software Inc.” Used under license
by FC-Datalogit

> Plots live charts of data logging or can be used to review saved logged data

o To open the Chart Window Click “"Chart” in the drop down Window menu,
once

= Resize the chart as required
= See {1-2-3-4-1 Chart (setup)} to setup the chart.

e Once you have set up the chart you can use it to view live data or
review logged data.

e You can open a saved log in the chart.

Questions? Manual@fc-datalogit.co.nz

21



FC-Datalogit FD3S User Manual

e You can move the curser line along the chart with the arrow keys or
scroll with a mouse

e Set up some watches and they will display the value of the watched
data where the curser line meets the plotted data line (trace)

e You can stretch or compress time by sliding the arrows on the time
line along the bottom of the chart

e You can alter the height of each chart by dragging the top or bottom
of each chart

I T-2 How the sample chart was created, Chart tutorial

1-2-3-1 File

£% FC-Datalogit - Untitled. txt
SN Log  Window  Setup

op
Save bs

Exit I
150

100

o} Dfop down File menu for Charts
» To access the following commands; Open, Save, SaveAs, and Exit
o To open the drop down File menu, Left Click “File”, once

1-2-3-1-1 Open

E4 FC-Datal ogit - Untitled. txt
FIEN Log  Window  Setup

Open
Save s F3

Ezxit
150

100

o Open an existing Chart File
» To Open an existing Chart file
o Left Click "Open” in the drop down File menu, once
= “Open” window will appear
»= Locate the file you wish to open
= Double left click the file you wish to open
= OR left click the file and left click the open button

1-2-3-1-2 Save as
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¥4 FC-Datalogit - Untitled. txt
FIEN Log  Window  Setup

Open |
Save As F3

Exit
150

100

o Save a Chart File under a different name
> Save a file
o Left Click "SaveAs” in the drop down File menu, once
» “Save As” window will appear
= Left click in the “File name” box and give the file a unique name
= OR, left click on an existing file
» Left click on the “Save” button
¢ If you choose to save a file using an existing file name, the original
file will be written over

1-2-3-1-3 Exit

£% FC-Datalogit - Untitled. txt
SN Log  Window g

Open
Save bs

Exxit
150

100

o Shut down Chart window
» To close Chart window
o Left Click “Exit” in the drop down File menu, once
e Chart settings will remain and the chart will look the same when you
reopen it

1-2-3-2 Log

4 FC-Datal ogit - Untitled.txt

200

150

100

o] Dfop down Log menu
» To access the following windows; Start and End
o To open the drop down Log menu, Left Click “Log”, once
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1-2-3-2-1 Start F1

#% FC-Datalogit - Untitled. txt

File MEM Window  Setup
Skart F1

el End FZ

200 -

150

100

o Start logging

» Starts logging the items chosen in the monitor window {1-2-1-6 Datalogit
Zone}

1-2-3-2-2 End F2

#% FC-Datalogit - Untitled. txt

File MEM Window  Setup
Start F1 |

el End FZ

200 -

150

100

o] Sfop logging
> Stops logging the items chosen in the monitor window {1-2-1-6 Datalogit
Zone}

1-2-3-3 Window

£2 FC-Datalogit - Untitled. txt

File Log BUGEEEN Setup

SEf 4 Map WPy
Add Watch

200

150

100

o} Di*op down Window menu
» To access the following windows; Map Watch, Add watch
o To open the drop down Window menu, Left Click *“Window”, once

1-2-3-3-1 Map Watch ﬁ

Questions? Manual@fc-datalogit.co.nz 24



FC-Datalogit FD3S User Manual

¥4 FC-Datalogit - Untitled. txt

File Log RSEEEEN Setup

SED 4 Map Watch
Add wWatch

200

150

100

o] Obens the Map Watch window {1-2-4 Map Watch}

1-2-3-3-2 Add Watch ™

E2 FC-Datal ogit - Untitled. txt

File Log RUEEECN Setup

250 4 Map Watch
add Watch

200

150

100

o] Obens the Add Watch window {1-2-5 Add Watch}

1-2-3-4 Setup

£2 FC-Datalogit - Untitled. txt

File Log ‘Window BSEEE
Chart

EED__ Monitor

200

150

100

o} Dl;op down Setup menu
» To access the following Chart Setup window
o To open the drop down Setup menu, Left Click “Setup”, once

1-2-3-4-1 Chart (setup)

£2 FC-Datalogit - Untitled. txt

File Log ‘Window BSEEE
Chart

EED__ Monitor

200

150

100

o} Sétup chart window

Questions? Manual@fc-datalogit.co.nz
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» To access the Chart Setup window
o Click “chart” in the drop down setup menu Setup chart window will appear

[ ]

Trace  Chart

Charts  Chart  BackColour Min Wal Aax val

i Es

Colour Mhin ital  Aha val

Item | (ronel

Done

Coption

|

[ Lo | IClick for Screen Capture {Setup Chart}

e You can have up to 4 charts
Click “charts” drop down box and select the humber of charts required
e You can give each chart a different background colour if required.
(Some trace colours are hard to see against certain background
colours)
Click “chart” drop down box and choose the chart humber then choose
desired background colour for that chart
e You can have a different scale for each chart
Click “chart” drop down box and choose the chart number then assign a
max and min value for that chart

Choose the number of traces you want to display and which chart you want

each one on
e Do this for as many traces you require
e You can have a maximum of 20 traces
Click “trace” drop down box and choose a trace number
Click “trace chart” drop down box and select which chart you want this
trace to be displayed on
Choose a colour for the trace
Choose a max and min value for the trace
Click the “Item” drop down box and choose the channel you want for the
trace
e The caption will reflect which channel you have chosen but you can
edit it if you wish
Click apply to view changes to the chart
Click Done when you are finished

1-2-3-4-2 Monitor

O

Opens the monitor window {1-3-1 Monitor (FC-Datalogit) }

1-2-4 Map Watch ﬁ
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% FC-Edit 2ZZGE - default. dat

File BNGEEES Tools  Setup

. Manibor T
! iaraph P
| Chart ND4 |ND5

Map 'Watch 00 1.000 1,000
addwatch Lo
p. fideiWatchs b4 oo 1.000
P05 [1.000 1.000 1.000 1.000 1,000
OB [1.000 1.000 1.000 1.000 1,000
PO7 [1.000 1.000 1.000 1.000 1,000
P08 [1.000 1.000 1.000 1.000 1.000

| Click for Screen Capture {Map Watch}

o Map Watch
» 20 x 20 map that displays logger data in it’s appropriate N & P position
e These are the same positions as the data and settings in your fuel
and ignition maps
e Only works for settings that you chose to log {1-2-1-6 Datalogit
Zone}
e Will display live data while creating a log
o Choose the log item you wish to analyse {1-2-4-6 Drop Down Channel
Selector}
e The most common items are wideband 02 and knock
o Choose max, min or average {1-2-4-7 Drop Down Filter} and go for a
drive...
o As you go up and down revs and load, 02 (or what ever item you choose)
will appear and fill up their relevant position in the map
o Look over the map watch map and adjust the fuel map accordingly
o Once you stop logging you can change the setting to a different item and
the map watch will crunch the log and fill up the map with the logged data

1-2-4-1 File N

EMap Watch
FIEN Log  Miew  Window  Options

op v| Ave) 0 Haold of
Save As L3 |NO4 [M05 [MOG [MO7 |MOog [N [M10 M1 |

Ezxit

e

FO3
FO4

o Drop down File menu
» To access the Open log window
o To open the drop down File menu, Left Click “File”, once
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N\

1-2-4-1-1 Open
] Map Waich
SN Log  Miew  Window  Options

- | A 0 Hold of

NO4 |MOS |MOE |WO7 |MOS | M09 |M10 [N11 |

Open
Save s F3

o Open a saved log file for analysis
» To Open a saved log file

o To Open a saved log file, Left Click "Open”, once

1-2-4-1-2 Save As

ﬁﬂap Waich
FIEN Log  Miew  Window  Options

Open - | Avg 0 Hold of:
Save As F3 |NO4 | NO5 | MOE |NO7 | Mg |NOS [N10 |N11 |
Exit

P03

P04

o0 Save Map watch

1-2-4-1-3 Exit

EMap Waich
FIEN Log  Miew Window  Options

Cpen & - | Ave) 0 Hold of

save As B3 s | Nog |MOS |MO6 |NO7 NS M09 [N10 N1 |

Exxit

FO3
FO4

o0 Close map watch

1-2-4-2 Log ﬁ

EMap Waich
File BEaM Yie indow  Options

Adva  Start F - |l 4 ~ |0 Hold of
q

End  F2 ) | NO5 | NOE [ NO7 | MO8 |MOT | M10 | M1

P01
POZ|
P03
P04
OS]
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o Drop down log menu

1-2-4-2-1 Start ™

EMap Waich
File BEM View ‘Window Options

Advg  Start F1 ng j KT Hold of
End 2 hNNJE |07 |Mog [Moa |10 [M11
P

P02
P03
P4
L] R S S -

o Remote Start logging
» Logs as per settings on the monitor window {1-2-1-6 Datalogit Zone}

1-2-4-2-2 End N

EMap Watch
File BEM ‘igw Window  Options

IE Start F1 ‘ j|,awg j 0 Haold of
|

End F2 MNO5 | NOB |ND7 |NOS |NO3 |N10 | MN1T

P01
02|
POz
PO4]
OS]

o Remote End logging

1-2-4-3 View

ﬁMap Waich
File Log BUESN ‘Window Options

|ﬁwg j ||:| Hold of
NOE |NO7 | MO8 | MOS [N10 [N11 |

Advanced
Nl:” GhDSt

=
"]
=l
=
[uT}
(w)

=il Col width ¥
Pz Dec. Flaces ¥
O3]
FO4
7o

o View drop down menu
» To setup the presentation of data viewed in the Map Watch
o To access the view drop down menu, Left Click “View”, once

1-2-4-3-1 Map Trace
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ﬁMap Waich
File Log BUESN ‘Window Options

Advanced Map Trace L vg j | 0 Hald of
08|

o | Shost MO7 | MO8 |Nog [N10 [N1T |
=l Colwidth  »
Pz Dec. Flaces ¥
P03
o4
OS]

o Map Trace for Map Watch
» Highlights the current P and N cell in use in the map window
o Click *Map Trace’ in the View drop down menu
e Shows you which cells are used for the current live engine condition
so you know which ones to edit

1-2-4-3-2 Ghost

EMap Waich
File Log BUEEM ‘Window Options

Adwanced | Map Trace E“AVQ j |0 Hald of

Ghosk
ﬁm ) NOE |MO7 MO8 [W09 [M10 |11 |
Pz Dec, Places »
[ZE
P04
P05,

o0 Ghost Map Trace for Map Watch
> Leaves a trail of the current P and N cell in use in the map window
o Click ‘Ghost’ in the View drop down menu

e Shows you which cells are used for the current live engine condition
so you know which ones to edit

1-2-4-3-3 Col Width

EMap Waich
File Log BHESN ‘Window  Options

W

Advanced Map Trace :HAVQ j |IZI Hald of
Ghost LEIE |MOE |MO7 |MOg | M09 |N10 [N11 |

|:-|:|-| Col Width
|:-|:|2 Cec. Places \

T3]
4]
Ps|
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EMap Waich
File Log BUESN Window  Options

Advanced | Map Trace EH’JWQ j E Hold of

M Ghask Ine | kine | king |NIIIE! |N|:|9 |N1IJ |N11 |
=N Col Width - Y ESEl
POZ| Dec. Flaces #|  Medium
PO3| T Large
P04
PE

o Column Width
» Choose size of column width
o Click Col Width then choose Small, Medium or Large

1-2-4-3-4 Dec. Places ™

EMap Watch
File Log BUEEN Window  Options

Advanced | Map Trace LEHEWQ j |0 Hold of

hosk
WM e 05 |NOB |MO7 |NO2 |ND3 |N10 |N11 |
= Dec. Flaces ¥
O3
P04
PO,

EMap Waich
File Log BUEEN ‘Window  Options

r

Advanced | Map Trace E”,q-.‘;g j |0 Hold of

MO | Ghost 05 | MOG |MO7 |Nog |Nog |10 [M11 |
PO Col width - # |
FiOz2 Cec. Places w 0
P03 ' 1
P4 2

]

4.

Pos
POE
Pav?

o Decimal Points
> Select Decimal points for data in map
o Click in text box and type in desired number of decimal points.

1-2-4-4 Window
EMapWatch

File Log Wiew

Window el jul "

!

Advanced Rpm Manikor 2 j |0 Hold of
NO1 [wNoz || Chart | NOg |Mog Mo N1 M1 |

P01
02|
O3
P4
OS]

o Window drop down
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» Drop down Monitor and chart opener

1-2-4-4-1 Monitor

i Map Waich

File Log “Wiew REGEECS Options
Advanced Rpm Monitar vy j |0 Hold of
NO1 |Woz || Chart NO7 |NDg |NOg [N1D [N1T |

P
FPz)
P3|
Fo4)
o5
o Open Monitor window

o Click Monitor in the Window drop down

1-2-4-4-2 Chart

i Map Watch

File Log Wiew BUGEEEN Cpkions
Advanced Rpim Manikar |ﬁwg j | 1] Hold of
NO1 [wNoz || Chart |MO7 MO8 Mo W10 M1 |

P01
02|
O3
P4
OS]

o Open Chart window
o Click Chart in the Window drop down

1-2-4-5 Options
EMapWatch

File Log “iew ‘Window eyt

pRef » j |0 Haold off (mSec)
NOE |MO7 |ND8 [MOg W10 [M11 |12 [ N1

|Au:|vanceu:| Rprn

MO |NO2 |M03 g | NOs

FO1
POz
FO3
FO4

o Drop down Map Reference selection window

1-2-4-5-1 MapRef ™
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i Map Watch

File Log ‘Miew Window Sl

|Hd\-‘ance;d Rprn RN ¢ Advanced Hold off (tnSec)
NOT |NO2 |ND3 | N4 | Nog || Legoed Lm | N12 | M1

P01

PD2

P03

P04

o Map Reference selection window
» Choose which set of map reference values you want to use
o Click Advanced or Logged

\

1-2-4-6 Drop down Channel selector

EMap Watch
File Log YWiew Window Options

Advanced Rpm

Advanced PIA,
Advanced PTH W

Advanced TPS Y

Advanced Injms

Advanced Inj /-

Advanced IGM

Advanced Duell bl

POa
o Drop down channel selector
> Drop down selection to select the channel of log data to be analyzed
o Watching while logging. Left click on drop down box and choose the
channel you wish to view
o Watching recorded logged data. Left click on drop down box and choose
the channel you wish to view. Wait for your computer to calculate the
values and populate the watch map
e No data in the selected channel? The map watch will only display
channels that are chosen to be logged in the monitor window

Dataloogit
[ Basic

[ Senzorz
[ Aux ASD
[ #hap Ref
[v Advanced

] Lines

e E.g. If you didn't check “Basic” from {1-2-1-6 Datalogit Zone} on the
monitor window when you created the log file then “Basic” channels
weren't logged, so the “"Basic” channels wont be able to be analysed
with Map Watch

1-2-4-7 Drop down Filter
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File Log Yiew ‘Window Options

|Adv-:l.n-:ed Rprm j|ﬁwg Haold of
NOT [MO2 |NO3 [ MNO4 | NoS N0 M1 |

PO
E
P3|
o4
PO5|

o Drop down filter selector

» Drop down selector to select the method of analyzing log data
o Choose max, min, average, number
e The longer you drive, the bigger the log file therefore you get more
samples of data for each position on the map.

= Choose Max. Wait while your computer searches the log file to find the
maximum value for each position in the map. The values displayed in
the map are peak values for each N & P position.

= Choose Min. Wait while your computer searches the log file to find the
minimum value for each position in the map.

= Choose Average. Wait while your computer searches the log file and
calculates the average value for each position in the map.

= Choose Number. Wait while your computer searches the log file and
counts the number of samples for each position in the map. The values
displayed in the map are total number of samples values for each N & P
position.

» Left click on arrow

= Left click on the desired method. Wait for your computer to calculate the
values in the map

1-2-4-8 Hold Off (m Sec) ™

File Log Wiew ‘Window Options

|Advanceu:| Rprn j|ﬁwg j m Hold of
NO1 |MO2 |M03 W04 |M0S |MOE |NO7 |No8 |NDS | N1

P01y

P02

P03

P04

P03

o Hold Off

» Sets the minimum time the active cell remains constant before the data is
used in the map watch

o Click in the box then type in the desired hold off time in milliseconds

1-2-5 Add Watch
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% FC-Edit 2ZZGE - default. dat

Marikar
raph

| Chart

Map Wakch

Add watch
Hide ‘Watchs

1 1.000) 1.000
0 1.000) 1.000
00 1.000 1.000
00 1.000 1.000

1.000)1.000)1.000 1.000) 1.000
1.000)1.000)1.000 1.000) 1.000
1.000)1.000)1.000 1.000) 1.000
1.000)1.000)1.000 1.000) 1.000

2 Setup Watch E@E|

Watch |4 yyarch |

Ttem |f\dvonced Rpm j

Caption  [wiatch 1

Faont... | 20pt Comic Sans MS
Colours Colour Mz Wal BackColour

Decimal Places IE‘

oK Cancel ‘

o Add Watch

Click for Screen Capture {Setup Watch}

> A pop up “Watch” which allows you to monitor a channel while you are logging
e You can have up to 10 Watches
o Choose “Add Watch” in the Window menu
o A “Setup Watch” window will appear
o Choose the Item (Channel) from the drop down window.

e You can choose any channel that can be logged in the Monitor

window

e The caption will display the channel you have chosen. You can edit

the channel name if you desire
e Choose a font and font size

e You can create a “red line” by assigning different text colours to

different values

o Coloured “red line”

o Example; RPM, text black until 6000rpm then red until 8000rpm then blue

o Click “3"” colours

o Select colour 1 in the drop down colour box, click the coloured box and

in the drop down “colours” box

select black, type 6000 in the "Max Val” box

o Select colour 2 in the drop down colour box, click the coloured box and

select red, type 8000 in the “"Max Val” box

o Select colour 3 in the drop down colour box, click the coloured box and

select blue

e You can drag the box and position it on your screen or drag it bigger

or smaller

e Once you have made a Watch if you want to alter it you can by
double left clicking it to go back to the “Setup Watch” window
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1-2-6 Hide Watch

% FC-Edit 2ZZGE - default. dat

File BNGEEES Tools  Setup
1 Manitor

Graph
Chart
Map Wakch

&dd Watch
Hide ‘Watchs

05 |1.000 1.000 1.000 1.000 1.000
06 |1.000 1.000 1.000 1.000 1.000
PO7 |1.000 1.000 1.000 1.000 1.000
POS |1.000 1.000 1.000 1.000 1.000
o Hide watches

» Hide watches from view

T|o|o|o|olo|

1-3 Setup ﬁ

% FC-Edit 2ZZGE - default,dat

File ‘Window Tools BS=Hd

INT Map! | TN

Burilary
NOT [NOZ [ i
P01 |1.000 1.000 1.000 1.000 1.000
P02 |1.000 1.000 1.000 1.000 1.000
P02 |1.000 1.000 1.000 1.000 1.000
P04 |1.000 1.000 1.000 1.000 1.000
POS |1.000 1.000 1.000 1.000 1.000
POE |1.000 1.000 1.000 1.000 1.000
P07 |1.000 1.000 1.000 1.000 1.000
P02 |1.000 1.000 1.000 1.000 1.000

o Drop down Setup menu (Alt w)
» To access the following windows; Port and Auxiliary
o To open the drop down Setup menu, Left Click “Setup”, once

N\

1-3-1 Com selection

%% FC-Edit 2ZZGE - default. dat
File ‘Window Tools BSEEN

Part 4

INT Map! | TGN

Buxilary

NO1 [MOZ | 5
PO1_|1.0001.000 1.000 1.0001.000
P02 |1.0001.000 1.000 1.000/1.000
P03 |1.0001.000 1.000 1.000/1.000
P04 |1.0001.000 1.000 1.000/1.000
P05 |1.0001.000 1.000 1.000/1.000
P0G |1.0001.000 1.000 1.000/1.000
P07 |1.0001.000 1.000 1.000/1.000
PO& |1.0001.000 1.000 1.000/1.000

o Com Port selection (Alt s)
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e The FC-Box is plugged into your computer via a "Com port”

ﬁ FC-Edit ?¥GE - default. dat
File ‘Window Tools

Auilary

MO |N|:|2 [T Coms3
PO1 [1.000 1.000 1.000 1.000 1, Cemd
POZ |1.000 1.000 1.000 1.000 1, Coms
PO |1.000 1.000 1.000 1.000 1  Comé
PO4 |1.000 1.000 1.000 1.000 1, Com?

FOS (1.0001.000 1.000 1.000/ 1) Comé
FOE (1.0001.000 1.000 1.000) 10007 77000777000
FO7 (1.0001.000 1.000 1.000 1.000) 1.000) 1.000
FO3 {1.0001.000 1.000 1.0001.000) 1.000) 1.000

> Allows you to choose between Communication Ports 1, 2, 3,4, 5,6, 70r 8
depending on which one you have plugged the FC-Box into
o To open the drop down Setup menu, Left Click “Setup”, once
o Click “Port” choose Com1 or Com?2 etc...

1-3-2 Auxiliary ﬁ

E FC-Edit 2Z7GE - default. dat
File ‘Window Taools

Setup

: : Part ]
INT Map! | TGN

Buxilary

NO1 [MOZ |
PO1_|1.0001.000 1.000 1.0001.000
P02 |1.0001.000 1.000 1.000/1.000
P03 |1.0001.000 1.000 1.000/1.000
P04 |1.0001.000 1.000 1.000/1.000
P05 |1.0001.000 1.000 1.000/1.000
P0G |1.0001.000 1.000 1.000/1.000
P07 |1.0001.000 1.000 1.000/1.000
PO& |1.0001.000 1.000 1.000/1.000

] Setup Auxilarys [Z] @l El

AN ANZ
Marme  |vide Band Marme |raw

‘folts Yalue  Unit Wolts alue

o [ Jar !Uiluilimi1
[ F 172 | O O

AMNZ Al
Marme  [raw Marme [raur

olts Walue  Unit Wolts Walue  Unit
o o U o o v
5 5 Paly 5 5 Paly

[ Delta AML-ANZ

[ Delta AM3-AM4 oK p— ‘

M (O Click for Screen Capture {Setup Auxiliary}
¢ AN inputs must be between 0~5 volts
o Set up Auxiliaries
» There are 4 Auxiliary channels and each has it’s own calibration depending on
what you connect to it.
e AN1, AN2, AN3 and AN4
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A1

Mame |Wi|:|e Bard
Walts Walue Unit
o |10 |A/F
|5 z0 Paly

AN1

o If the output of the item you are logging is linear then you only need to
enter values for two voltages to define the slope.

o More complex outputs, where the output can be defined with a curve,
require a formula (a polynomial) Click the Poly button on the AN window
and enter the values for a, b and c. {1-3-2-1 Polynomial}

e There is a separate scale factor box for each AN channel

o For example, if you want to connect a particular Wideband 02 sensor
controller which has a linear output. You need to define two voltages and
their relative A/F values.

o Perhaps at 0 volts the A/F is 10 and at 5 volts the A/F is 20.
Al

rMarne |Wiu:|e Eand

Woltz alue Unit

|EI |1IZI |AHF h
|5 |20 Paly

Name the output units, in this case A/F.
o Name the item so you can find it in your log
= In this case a voltage of 2.5V will display an A/F value of 15 (:1).
e You need to find the correct scale factor for the sensor you are using.

1-3-2-1 Polynomial (Setup) ﬁ

A1

Mame |Wi|:|e Bard
Walts Walue Unit
o |10 |A/F
|5 z0 Paly

yzax"2+bx+e¢

a o
b 2

c o

ag Canecel ‘

Click for Screen Capture {Setup Polynomial}
¢ AN inputs must be between 0~5 volts
o Polynomial Window
> Pop up window where you can input the values of a, b and c to define a curve
to calibrate an AN input to be logged
e More complex inputs, ones that can be defined by a curve, require a
formula (a polynomial)
o Click the Poly button on the AN window and enter the values for a, b and c.
= For example. DIY Wideband set up. The graph of A/F vs. Output voltage
is not a straight line.
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» The easiest way to create the polynomial is to plot the values from the
graph in to excel then use the “trend line” function. The “trend line”
function will create a “best fit” curve by using a polynomial formula.
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Above is a picture of an xy graph on the values from the DIY A/F vs.
Voltage graph.
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= Un fortunately the curve of this graph doesn’t allow for a very nice

polynomial.
v o= 4 4689x%-13.101% + 20.1549
-
;—"'-
2 ;
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;ir
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» Above is a picture of the same values from the DIY A/F vs. Voltage and
the resulting polynomial. The values for a, b and c are unusable because
the curve they describe is not close enough to the actual curve of the
plotted values.

= Luckily we are really only interested in the values that represent the A/F
ratio between 10:1 ~15:1. If we limit the graph to that range and
create the polynomial we get the following graph;
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a0F

1.2 15 1.7 148 21 13 2.4 ¥ 14
Wolts

= This graph gave us the values we use for our DIY wideband.
» A=1.6344 b=2.1693 and C= 9.9414
e You can follow the same procedure to create a polynomial for other
Sensors.

1-3-2-2 Delta AN1- AN2

i Setup Auxilarys B2 Setup Auxilanys

Akl AMZ . AML - AMZ A2
Mame  \wide Band Marne E : Mame  wide Marme E
Yaltz Yalue nit Yaltz | Valtz Yalue it Valtz 'u

f o b TR o Nk
Com Fra 7 [N o B R o P (R R

AMS Arld | AM3 Arld
Marre | paw Marrie E 1 Mame  |row Marme E
Yaltz Yalue nit Yaltz Valtz Yalue nit Valtz 'u

o
o b W b T ]F B BT
B woy| | |5 |

[ Delta AM1-AMZ I ¥ Delta ARL-ARE

[ Delta ARS-AR4 oK I T Delta ARS-AR4 oK
[ ReCaloulate Lag 1 [ Recaleulate Log
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1-3-2-3 Delta AN3 - AN4 D

AMZ AN AMS - AN AN
Mame [ Mame g Mame [ Mame g
Walts Walue  Unit Walts ] Walts Walue Walts ]
0 0 [ 0 [ 0 0 i 0 [
5 5 Paly || |5 [ 5 [
[ Delta AML-ARMZ
L v L
[ Delta AMS-AMN4 oK W Delta ARS-AMN4 aK
[ Recaleulate Log [ Recaleulate Log

1-3-2-4 ReCalculate Log >

[ Delta AML-AMZ
[ Delta AMS-ARNG

NO1 [MO2 [ND3 [MO4 [MNOS

P01 {1.000 1.000 1.000) 1.000) 1.000
FO2 {1.000 1.000 1.000) 1.000) 1.000
FO3 {1.000 1.000 1.000 1.000) 1.000
FO4 {1.000 1.000 1.000 1.000) 1.000
P05 {1.000 1.000 1.000) 1.000) 1.000
POE {1.000 1.000 1.000 1.000) 1.000
PO7 {1.000 1.000 1.000 1.000) 1.000
FOZ2 [1.000 71.000 1.000) 1.000) 1.000

o Drop down Tools menu (Alt w)
» To access the ReCalc Base window
o To open the drop down Setup menu, Left Click “Setup”, once

1-4-1 ReCalc Base
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4 FC-Edit 2ZZGE - default.dat

File window RfEEE

; ; ReCalc Base —
 {Th VT ———

NO1 [MO2 [ND3 [MO4 [MO
PO1_|1.000/1.000 1.000 1.000/1.000
P02 |1.000/1.000 1.000 1.000/1.000
P03 |1.0001.000 1.000 1.000 1.000
P04 |1.0001.000 1.000 1.000 1.000
P05 |1.000/1.000 1.000 1.000/1.000
POE | 1.000/1.000 1.000 1.000/1.000
P07 |1.000/1.000 1.000 1.000/1.000
PO2 |1.000/1.000 1.000 1.000/1.000

o ReCalc Base
> Resets all values in the INJ (correction) map to 1.000 and recalculates the
base fuel map accordingly
o To open ReCalc, Left Click “ReCalc”, once in the Tools drop down menu

1-5 Read All

F13 (1.000 1.000 1.000 1.000 1.000) 1.000) 1.000) 1.000)1.000)1.000)1.000 1.000 1.0007 1.000) 1.0
F20 (1.0001.000 1.0001.000 1.000) 1.000) 1.000) 1.000)1.000)1.000)1.000 1.000 1.0000 1.000) 1.0

Read ‘ ite ‘

Read All Write All Update [ MhapTracer

o Read All (Altr)
» Copy ALL SETTINGS AND MAPS from a Power FC to FC-Edit

e Read ALL SETTINGS AND MAPS held in the Power FC memory and
copy ALL to the appropriate windows in FC-Edit so they can be saved
and edited

o Click the “"Read All” Button on the Bottom of FC-Edit

¢ There is no auto save so “Read All” will delete the current settings in
FC-Edit

+ Save files or you will loose the datal!

1-6 Write All

F13 (1.000 1.000 1.000 1.000 1.000) 1.000) 1.000) 1.000)1.000)1.000)1.000 1.000 1.0007 1.000) 1.0
F20 (1.0001.000 1.0001.000 1.000) 1.000) 1.000) 1.000)1.000)1.000)1.000 1.000 1.000 1.000) 1.0

Read ‘ Whrite ‘

Read All Write All

o Write All (Alt a)
> Transfer ALL SETTINGS AND MAPS from FC-Edit to a Power FC
e Copy ALL SETTINGS AND MAPS held in FC-Edit and write ALL to the
Power FC memory
o Click the “Write All” Button on the Bottom of FC-Edit
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¢ We suggest you “Read all” the settings and maps and save the file
before you start editing

Save files or you will loose the data!

Before you “Write All”, We suggest you Switch Off the engine and
turn the ignition to “on”

%o Yo

1-7 Update
P19 |1.000 1.000) 7.0000 1.000] 1.0001.000 1.000) 7.000] 1,000 1000 1.000 1000 1.000 7000/ 1.(
P20 |1.000 1.000) 7.0000 1.000] 1.0001.000 1.000) 7.000] 1,000 1000 1.000 1000 1.000 7000/ 1.(

Read ‘ Whrite ‘

Read All Write All Update ™ MapTracer

o UpDate (Alt u)

» Transfer altered SETTINGS and INDIVIDUAL CELLS from FC-Edit to a Power
FC

e Copy SETTINGS and INDIVIDUAL CELLS from Maps that have
changed recently and in FC-Edit and write them to the Power FC
memory

o Click the “Update” Button on the Bottom of FC-Edit

¢ We suggest you “Read all” the settings and maps and save the file
before you start editing
Save files or you will loose the data!

Before you “Update”, We suggest you Switch Off the engine and turn
the ignition to “on”

o Xo

1-8 Map Tracer

F13 (1.000 1.000 1.000 1.000 1.000) 1.000) 1.000) 1.000)1.000)1.000)1.000 1.000 1.0007 1.000) 1.0
F20 (1.0001.000 1.0001.000 1.000) 1.000) 1.000) 1.000)1.000)1.000)1.000 1.000 1.0000 1.000) 1.0

Read ‘ Write ‘

Read All Write All Update [ MhapTracer

o Map Trace
» Highlight current P and N cell in use in the map windows

e Shows you which cells are used for the current live engine condition
so you know which ones to edit
o Check the “"Map Tracer” check box at the Bottom of FC-Edit
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bt | | Click for Screen Capture {INJ Map}
o The Base fuel maps
» The Base fuel maps represent a mixture of 14.57:1 for a stock engine. The
Fuel Correction Map is used to achieve a more suitable mixture
o The Values in the Fuel Correction Map theoretically equal 14.57 / desired mixture
e i.e. If you want a mixture of 12:1 then the correction value would be
14.57 /12 = 1.214.
e This is the theory but you really need to confirm the mixture with a
wideband O2 sensor
o Altering values in the Fuel Correction Map
= You can enter a new value directly into a cell (or a range of cells) in
the map. Left click on the desired cell (left click drag, release, to
select a range of cells) then type in the new value and hit “enter”.
= You can increase or decrease the value of one cell (or a range of
cells) by left clicking on a cell (left click drag, release, to select a
range of cells),
e “+” or“-" The value will increase or decrease by 0.0039.
e “Ctrl +” or “Ctrl =" and the value will increase or decrease by
0.039
= You can copy (Alt c) or paste (Alt v) values to and from or around the
map
e Tuning required for a modified engine may exceed the range of
the Fuel Correction Map. You might need to adjust the values in
the Base Fuel Maps
e PO1~P20 {N-3 Pressure Value} in the Fuel and Ign Maps
e NO1~N20; RPM. See {C-1 Map Reference}
e Scales for P and N can be adjusted, see section {C-1 Map
Reference} for more information

2-1 Read Injection Map ﬁ

F19 1117 1117 1.117 237 1137/ 1.156
F20 (1117 1117 1141137 1137 1.156
Read Whrite ‘

Read All Write All

o Copy the Fuel Correction Map from a Power FC to FC-Edit
» Read the Fuel Correction Map held in the Power FC memory and copy it to the
“Injector Map” window in FC-Edit so it can be saved and edited
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o Click the “Injector Map” Tab to bring the Injector Map window to the front
o Click the “"Read” Button on the Injector Map window

2-2 Write Injection Map ﬁ

F19 (1117 1117 1117 1137 1,137 1.1586
F20 (1117 1117 1117 1137 1.137 111

Read ‘ Whrite

Read All Write All

o Transfer the Fuel Correction Map to a Power FC from FC-Edit
» Copy the Fuel Correction Map from the “Injector Map” window in FC-Edit and
write it in the Power FC memory
o Click the “Injector Map” Tab to bring the Fuel Correction Map window to the
front
o Click the “"Write” Button on the Fuel Correction Map window
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3- Ignition Map ﬁ

Feod Write

bt | | Click for Screen Capture {IGN Map}
o Ignition Map
» Altering values in the Ignition Map
o You can enter a new value directly into a cell (or a range of cells) in the
map. Left click on the desired cell (left click drag, release, to select a range
of cells) then type in the new value and hit “enter”.
o You can increase or decrease the value of one cell (or a range of cells) by
left clicking on a cell (left click drag, release, to select a range of cells)
= “4+” or “-" The value will increase or decrease by 1 deg
= “Ctrl +” or “Ctrl =" The value will increase or decrease by 10 degrees
= You can copy (Alt c) or paste (Alt v) values to and from or around the
map
e P01~P20 {N-3 Pressure Value} in the Fuel and Ign Maps
e NO1~N20; RPM. See {C-1 Map Reference}
e Scales for P and N can be adjusted, see section {C-1 Map Reference}
for more information

3-1 Read IGN Map

F13 |1 13 11 5 4
F20 (1 3 1 11 11 5 3
Read Whrite ‘

Read All Write All

o Copy the Ignition Map from a Power FC to FC-Edit
» Read the Ignition Map held in the Power FC memory and copy it to the “IGN
Map” window in FC-Edit so it can be saved and edited
o Click the “IGN Map” Tab to bring the Ignition Map window to the front
o Click the “Read” Button on the IGN Map window

3-2 Write IGN Map

FIg [1 2 12 11 11 &
F20 (1 2 12 11 1 3
Read ‘ Whrite ‘

Read All Write All
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o Transfer the IGN Map to a Power FC from FC-Edit
» Copy the Ignition Map from the “IGN Map” window in FC-Edit and write it in
the Power FC memory
o Click the “IGN Map” Tab to bring the Ignition Map window to the front
o Click the “Write” Button on the Ignition Map window
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4- VT Map

bt | | Click for Screen Capture {VVT Map}
o VVT Ignition Map
» Altering values in the VVT Map
o You can enter a new value directly into a cell (or a range of cells) in the
map. Left click on the desired cell (left click drag, release, to select a range
of cells) then type in the new value and hit “enter”.
o You can increase or decrease the value of one cell (or a range of cells) by
left clicking on a cell (left click drag, release, to select a range of cells)
= “4+” or “-" The value will increase or decrease by 1 deg
= “Ctrl +” or “Ctrl =" The value will increase or decrease by 10 degrees
= You can copy (Alt c) or paste (Alt v) values to and from or around the
map
e P0O1~P20 {N-3 Pressure Value} in the Fuel and Ign Maps
e NO1~N20; RPM. See {C-1 Map Reference}
e Scales for P and N can be adjusted, see section {C-1 Map Reference}
for more information

4-1 Read VVT Map

F13 |1 13 11 5 4
F20 (1 3 1 11 11 5 3
Read Whrite ‘

Read All Write All

o Copy the VVT Map from a Power FC to FC-Edit
» Read the VVT Map held in the Power FC memory and copy it to the “VVT Map”
window in FC-Edit so it can be saved and edited
o Click the “VVT Map” Tab to bring the VVT Map window to the front
o Click the “"Read” Button on the VVT Map window

4-2 Write VWT Map

FIg [1 2 12 11 11 &
F20 (1 2 12 11 1 3
Read ‘ Whrite ‘

Read All Write All
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o Transfer the VVT Map to a Power FC from FC-Edit
» Copy the VVT Map from the “VVT Map” window in FC-Edit and write it in the
Power FC memory
o Click the “VVT Map” Tab to bring the VVT Map window to the front
o Click the “Write” Button on the VVT Ignition Map window
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5 Base Fuel Map

Read Write

B | i Click for Screen Capture {Base Map}
o} The Base fuel map represents the a mixture of 14.57:1 for a stock engine
e Values are Injector pulse width in mil/sec
e Tuning required for a modified engine may exceed the range of the
{2 Fuel Correction Map} You might need to adjust the values in the
Base Fuel Map
» Altering values in the Base Fuel Map
o You can enter a new value directly into a cell (or a range of cells) in the
map. Left click on the desired cell (left click drag, release, to select a range
of cells) then type in the new value and hit “enter”.
o You can increase or decrease the value of one cell (or a range of cells) by
left clicking on a cell (left click drag, release, to select a range of cells)
= 4" or"-" The value will increase or decrease by 0.0039.
= “Ctrl +” or “Ctrl =" and the value will increase or decrease by 0.039
= You can copy (Alt c) or paste (Alt v) values to and from or around the
map
e P01~P20 {N-3 Pressure Value} in the Fuel and Ign Maps
e NO1~N20; RPM. See {C-1 Map Reference}
e Scales for P and N can be adjusted, see section {C-1 Map Reference}
for more information

5-1 Read Base Map

F13 |11.66 1166 1099 1367 1322 13.14
P20 |1268 1268 11.99M3 21 1437 14.26
Read Write ‘

Read All Write All

o Copy the Base Fuel Map from a Power FC to FC-Edit
> Read the Base Fuel Map, held in the Power FC memory and copy it to the
“Base Map” window in FC-Edit so it can be saved and edited
o Click the “"Base Map” Tab to bring the Base Fuel Map window to the front
o Click the “"Read” Button on the “"Base Map” window

5-2 Write Base Map
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F13 [11.66 11.66 1093 1217 13.22 1314
F20 (1265 1265 11.94 13.21 14.37 14.25

Read ‘ Write

Read All Write All

o Transfer the Base Fuel Map, to a Power FC from FC-Edit

» Copy the Base Fuel Map, from the “"Base Map” window in FC-Edit and write it

in the Power FC memory
o Click the “Base Map” Tab to bring the Base Fuel Map window to the front
o Click the “"Write” Button on the Base Fuel Map, window
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- s On

Samngs 3 | mnge 4 | e 3] Fotan |

e N

[E1E|)

ettt dot

Setting

Rewd 1 | wrive a1 Click for Screen Capture {Settings 1}
o Page one of the setting windows
» The following settings are on "Settings 1” and can be edited and transferred
between FC-Edit and the Power FC
e Boost Control
Rev / Idle
Function Select
Knock Warning
02 Feedback
Map / Settings Protection
Version
o Click the “Settings 1” Tab to bring Page one of the setting windows to the
front

A-1 Boost Control

Boost Control

Boost Dty
& 1. |0.&0 |24 |
2. |1.oo 144 |
3110 |50 |
4. 1z0 |56 |

o Boost Control Setting
> Boost settings; there are four setting groups 1, 2, 3 and 4
e You could set one for low boost (cruising?) and another for a higher
boost (Overtaking?)

Boost Cantral

Boost Gty
& 1 |nan 24 |
- PR [aa |

» Setting group 1
o Use mouse to select which boost setting group you want to use, Click the
appropriate switch
o Or you can use the FD-Box Remote Boost Switch {E-3-2 Remote boost

switch} to switch between settings 1 and 3 “on the fly”
Boost Control

Boost Gty
Cn T 24 |

i~ 2 Ihan laa |
o Boost
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» Boost value is the target boost value the Boost Control System tries to reach
and hold
o Click in the box and type in the desired Value
¢ {W-2 BOOST CUT}, Fuel cut will occur if boost reaches 0.25 Bar
above the Target Boost value
{W-3 Exhaust Temp Light flashing!} Over 1.2 Bar the factory Map
sensor will not be accurate. Exhaust Temp Light will flash when Boost
is over 1.1 Bar {N-1 Factory Boost Sensor}

o

Eoost Control

Eoozt
# 1 |oao

~ 7 I an laa |
o Duty
» Duty setting determines the Waste Gate Control Solenoid’s initial position (%

opening) before the Boost Control system starts to control boost
o Click in the box and type in the desired Value
e If the number is too LOW, boost will lag and take more time to reach
the desired Boost level. This will cause no damage but may make the
car feel sluggish
e If the number is too HIGH, boost may spike and over shoot the
desired boost level before settling back down
A Boost Spike out of the range of your INJ and IGN maps may cause
engine damage. Be careful!

Xo

A-2 Rev / Idle N

Rev & Idle

Rew Limit |g300

FACAE |an00
FACESL 5600
FACA/C 1100
Idle AE (1300
Idle E/L [aoo0
Idle A/C [a50

o Adjust Engine speed for various conditions
> For all Rev Idle Settings, Choose the parameter and type in the new value
o Use mouse to select the desired text box and type in the new value

A-2-1 Rev Limit

o Max Rev Limit.
» Set the max revs the engine will rev to
o Click in the text box and type in the new value
¢ Hard fuel cut so use it as a safety device
e Power FC Pro version uses the same box but is ignition cut instead of

fuel cut. Much safer
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e If you use an auxiliary Rev Limiter, increase A-2-1 Rev limit to a
higher value than you set the auxiliary Rev Limiter so Power FC Rev
limiter doesn’t function

e The commander will only let you set the rev limiter to a maximum of
9999 rpm... With Datalogit you can set the rev limit to values grater
than 9999. If you set the limit to 12,000 the commander will show
2000 rpm because it can only display 4 numbers.

A-2-2 F/CA.ED
FFCAE |sooo

o Deceleration Fuel cut recovery when no Electric Load present and Air conditioning
is off
> Set the revs the injectors will turn back on when decelerating
o Click in the text box and type in the new value

A-2-3 F/C E/L
FFCE/L |se00

o Deceleration Fuel cut recovery when Electric Load is present
> Set the revs the injectors will turn back on when decelerating
o Click in the text box and type in the new value

A-2-4 F/C A/C D

o Deceleration Fuel cut recovery when Air conditioning is on
> Set the revs the injectors will turn back on when decelerating
o Click in the text box and type in the new value

A-2-5Idle A.E D
Idle AE [1300

o Idle when no Electric Load present and Air conditioning is off
» Set the RPMs the power FC will try to get the engine to idle at
o Click in the text box and type in the new value
I Idle. The Power FC has a built in learning function for idle
stabilization. When you first get your Power FC and plug it in you
should make sure the air-con and other accessories are switched off,
turn on the engine and let it sit for 10 minutes. The idle should
stabilize (Assuming your car is not too heavily modified that it wont
idle and you still have an O2 sensor and A-4-4 02 F/B Control is
activated)

A-2-6 Idle E/L
Idle E/L [aoo0

o Idle when Electric Load present
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» Set the RPMs the power FC will try to get the engine to idle at
o Click in the text box and type in the new value
I Idle. The Power FC has a built in learning function for idle
stabilization. When you first get your Power FC and plug it in you
should make sure the air-con and other accessories are switched off,
turn on the engine and let it sit for 10 minutes. The idle should
stabilize (Assuming your car is not too heavily modified that it wont
idle and you still have an O2 sensor and A-4-4 02 F/B Control is
activated)

A-2-7 Idle A/C D

Idle ASC  |g50

o Idle when Air Conditioning is on
> Set the RPMs the power FC will try to get the engine to idle at
o Click in the text box and type in the new value
I Idle. The Power FC has a built in learning function for idle
stabilization. When you first get your Power FC and plug it in you
should make sure the air-con and other accessories are switched off,
turn on the engine and let it sit for 10 minutes. The idle should
stabilize (Assuming your car is not too heavily modified that it wont
idle and you still have an O2 sensor and A-4-4 02 F/B Control is
activated)

A-3 Function Select ﬁ

Function Select

o Function Selection

» Switch on or off the following Functions;
Boost Control Kit

Injector / Airflow Warning

Knock Warning

02 F/B Control

Idle-IG Control

<1 <1 <1 <1 71

O O0OO0OO0oOo

A-3-1 Boost Control Kit

Function Select

1.BEoost entl kit I

o0 Boost control Kit
» Switch Boost control Kit Control {A-1 Boost Control} on or off
o Check box for Boost control Kit
o Uncheck box for N/A

Questions? Manual@fc-datalogit.co.nz 56



FC-Datalogit FD3S User Manual

o Use mouse to Check or Uncheck the “"Boost control Kit” check box
e Use; {A-1 Boost Control} to edit actual Boost Control Settings
e Apexi single turbo boost control kit {N-4 Boost Control Kit for single
turbo}

A-3-2 Injector / Air Flow Warn ﬁ

o Injector / Air Flow Warning
» Switch Injector / Air Flow Warning {W-4 Check Engine Light Flashing Slowly!
Injector Duty / Map Warning} on or off
o Check box for Injector / Air Flow Warning.
o Uncheck box if you DON'T want Injector / Air Flow Warning
= Use mouse to Check or Uncheck the “Injector / Air Flow Warn” check
box

A-3-3 Knock Warn ﬁ

o Knock Warning
» Switch Knock Warning {W-5 Check Engine Light Flashing Quickly! Knock
Warning} on or off
o Check box for Knock Warning. Uncheck box if you DON'T want Knock
Warning
» Use mouse to Check or Uncheck the “Knock Warn” check box
e Use; {A-5 Knock Warning} to edit actual Knock Warning Settings
e {N-2 Knock Value}
¢ {W-5 Check Engine Light Flashing Quickly! Knock Warning}

A-3-4 02 F/B Control

02 F/E Contral v

o 02 Feedback Control
> Switch 02 Feedback Control on or off
o Check box for O2 F/B Control.
o Uncheck box if you DONT want O2 F/B Control
= Use mouse to Check or Uncheck the 02 F/B Control” check box
e Use; {A-6 O2 Feedback} to edit actual O2 Feedback Settings
e Switch off if your O2 sensor is faulty or “missing”

A-3-5 Idle-IG Control
5Idle-Is cntrl v

o Idle Ignition Control
» Switch Idle Ignition Control on or off
o Check box for Idle-IG Control.
o Uncheck box if you DONT want Idle Ignition Control
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= Use mouse to Check or Uncheck the “Idle-IG Control” check box
e Switch off if you want to check ignition timing with a timing light

A-4 Version ™

Wersion

Program String 1 SE-REW 2
Program version |2 01E

o Version Display

» When FC-Datalogit is connected to a Power FC this Displays the Power FC’s
model and software version
o Program String

» Displays which Model Engine the Power FC is designed to control
o Program Version

» Displays which software / program version is in the Power FC

A-5 Knock Warning ﬁ

Kniack: Wiarmn

&0 Threst
= Setting

o Adjust Knock Warning {W-5 Check Engine Light Flashing Quickly! Knock
Warning} Thresh hold and Setting

e Knock Warning can be switched off, see; {A-3-3 Knock Warn}

&0 Thresk

» Enter Value Knock Warning Thresh hold Value. Peak Knock Value to turn on
Check Engine Light

o Use mouse to Enter desired Value for Knock Warning Thresh hold in

“Thresh” Box.
e {N-2 Knock Value}
a Setting

» Enter Setting Value. Flashing Interval time for Check Engine Light
o Use mouse to Enter desired Flashing Interval Time Value for Knock
Warning in “Setting” Box

A-6 02 Feedback ™

07 Feedback

1.047 Setting

o Adjust 02 Feedback Control Setting

> Used to (self learn) fine tune mixture at idle for emission control and idle
stabilization

Questions? Manual@fc-datalogit.co.nz



FC-Datalogit FD3S User Manual

> Is used for “Lean Cruise”. Leans mixture if TPS value doesn’t change for a
while. Saves gas on long trips

1.047 Setting

02 Feedback Control can be switched off, see; {A-3-4 02 F/B
Control}

> Enter Setting Value
o Use mouse to Enter desired O2 Feedback Control in “Setting” Box

Switch off if your O2 sensor is faulty or “*missing”

A-7 Protect

Protect

[ Ian Map
[ InjMap
[ PIa Wolt
[ Injectar
[ Boost

[ Accelerate
[ Ian/TInj
[ cranking
[ Wrtr Temp
[ Rev/Idle

o Protect

» Protect or Un-Protect Maps and Settings
o Check or Uncheck check boxes
o Use mouse to Check the check box of the item you want to protect
o Or Uncheck the items you want to edit

OO O0OO0ODO0OO0ODO0OO0ODO0OO0 o o

Stops unauthorized people from looking at or altering your settings
with a commander

Won't stop unauthorized people from looking or adjusting if they also
have Datalogit :)

Lets you un-protect Maps and Settings protected with Power Exel

The following items can be protected (or unprotected)
IGN Map; {3- Ignition Map?}.

Inj Map; {2- Fuel Correction Map (Injector Map)}.
PIM Volts

Injector Settings

Boost Settings

Accelerate Settings

Ign and Inj; Tuning Adjust Settings

Cranking

Water Temp Settings

Rev / Idle Settings
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B-

0 2T - dedaiah da

.......

ettings Two ﬁ

et | e 8 Click for Screen Capture {Settings 2}
o Page two of the setting windows

» The following settings are on “Settings 2” and can be edited and transferred

between FC-Edit and the Power FC
0 Water Temp Correction

Accelerate Injector Time
Cranking Time
Injection vs. Acceleration TPS1

O O0OO0OO0OO0OOo

(0]

Injection vs
Injection vs
Injection vs
Injection vs

. TPS

. Air Temp

. Air Temp and Boost

. Water Temp and Boost

o Click the “Settings 2” Tab to bring Page one of the setting windows to the
front

N\

B-1 Water Temp Correction

Yifater Temp Correction

+80C 1000 |1.000
+50C 1047 1078
+30C 1094 [1.141
#0C 1188 |1.297
-10C 1591|1594
-30C 1594|1891

o Adjust Fuel mixture for varying engine operation temperature as engine comes
up to normal operating temp
» For each temperature range, choose the parameter and type in the new value
o Use mouse to select the desired text box and type in the new value

B-2 Accelerate Injector Time

Accelerate Injector (n5)

B P, Amount  Decay
\soo0 4400 |0.800
l4000  |4100  |0.800
|zoo00 |s.s00 |oFoo
|zooo  |3.500  |0.600
ltooo |s.zoo |o.s00
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o Fuel enrichment for sudden acceleration (Like an accelerator pump)
» For each RPM range, choose the parameter and type in the new value
o Use mouse to select the desired text box and type in the new value

N\

B-3 Cranking Time
Cranking (fn5)
0[5
+50C [100
+30C [1e0
+0C  [zen
-10¢ [s30
-30C [1110

o Injector on time while cranking the engine (ms)
» For each temperature range, choose the parameter and type in the new value
o Use mouse to select the desired text box and type in the new value

B-4 Injection vs. Acceleration TPS1 ﬁ

Inj vz Accel TPS1

Tnput Setting

l1z& 230
|50 173
16 10z

o Injector enrichment
» Injector enrichment vs. acceleration of the throttle
o Use mouse to select the desired text box and type in the new value

B-5 Injection vs. TPS

INTw=TP3S

TPS% Setting

595 1.125
79T 1.125
69.9 1.125
59.5 1.078
|50.0 11.05%9
139.5 1.000

o Fuel correction
» Adjust Fuel correction vs. Throttle Position
o Use mouse to select the desired text box and type in the new value

B-6 INJ vs. Air Temp
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Inj w= AirTemp

+80C  [n93g
500 [n9ss
#5300 [rooo
H0C  [1ozo
06 [1oge
-30C  [1ose

o Injector enrichment vs. Air temp
» Adjust Fuel mixture for varying Manifold air temperature as engine comes up

to normal operating temp
o Use mouse to select the desired text box and type in the new value

B-7 INJ vs. Air Temp & Load

IMNT vws Air Temp and Boost (frae)

Termp Setting Boost

El 11000 7934
70 11000
|60 11000 600

o Injector enrichment vs. Air temp and load
» Adjust Fuel mixture for varying Manifold air temperature and Boost
o Use mouse to select the desired text box and type in the new value

B-8 Inj vs. Water Temp & Load ﬁ

IMNT vs Wiater Temp and Boost (nas)

Temp Setting Boost
1100 11.078 To36

ET 1.000 3540

o Injector enrichment vs. Water temp
» Adjust Fuel mixture for varying engine operation temperature around normal
operating temp
o Use mouse to select the desired text box and type in the new value
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C- Settings Three N

—
CEm

T

| - . Click for Screen Capture {Settings 3}
o Page three of the setting windows
» The following settings are on “Settings 3” and can be edited and transferred

between FC-Edit and the Power FC
o Map Reference
o Air Flow
e Click the “Settings 3” Tab to bring Page one of the setting windows to

the front

N\

C-1 Map Reference

Map Reference

Boost RPN
01 500 400
0z (1000 a0
03 (2000 1200
04 (3000 1400
05 (4000 2000
06 (5000 2400
0y |&o00 2500
0s |Fooo 3200
0% |go00 3600

10 2000 4000
11 |1000ao0 4400
12 11000 4300
13 12000 300
14 13000 3600
15 |14000 a0ao
1a |13000 a400
17 |1a000 a0
13 |170ao FEao
12 |13000 Fago
20 12000 goao

o Calibrate P and N
» This Table allows you to recalibrate the scale of P and N for the main maps
o Enter desired values into the Map Reference Table
e There is only one Map reverence Calibration table for all four maps;
Fuel correction, Base fuel, Ign and VVT
e P01~P20 {N-3 Pressure Value}
e NO1~N20; Engine RPM

C-2 Air Flow N
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Air Flow
1 |1277GE 0.64% |100.0
LZ8Y |ioo.n
" 2 |2.0ption 1
prien 1L92% [100.0
" 3 |3.0ption 2 2.56Y |1o0.0
3.20¥ |ioo.n
" 4 |4 Option 3
pHon 3.84Y [100.0
" 5 |5.0ption 4 4.48Y |1o0.0
5.12% |ioo.o

o Air Flow Meter
» With some Power FC models the user can install a larger airflow meter to
reduce restriction
e All voltages set at 100.00 for the stock airflow meter
o If a different meter is installed type in new values to calibrate it
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D- Settlngs Four 7~ N

B | e e Click for Screen Capture {Settings 4}
o Page four of the setting windows
» The following settings are on “Settings 4” and can be edited and transferred
between FC-Edit and the Power FC
o Ignition vs. Water Temp (cool)
Ignition vs. Water Temp
Boost vs. IGN S.F.
Ignition vs. Air Temp
Ignition vs. TPS
Ignition vs. Battery Voltage
Ignition vs. RPM
o Click the “Settings 4” Tab to bring Page one of the setting windows to the
front

O O0OO0OO0O0OOo

D-1 Ignition vs. Water Temp (cool)

ISM vs WiaterT Cool

Temp Retard

50 E

R 15

o Ignition vs. Water Temp (cool)
» Ignition vs. Water temperature during warm up
o For the standard setting; ignition is retarded by an extra 15 degrees until
the water temperatures reaches 60 degrees C, then reduces retard until no
extra retard at 65 degrees C or over
o Use mouse to select the desired text box and type in the new value

D-2 Ignition vs. Water Temp

L=k we YWilaterT

Ternp Retard
1100 |5

|20 0

o Ignition vs. Water Temp
> Ignition vs. Water temperature if the engine starts getting too hot
e For the standard setting; at 90 degrees C or less ignition timing is
not corrected. From 90 ~ 100 timing is additionally retarded lineally
to a max of 5 degrees. All temperatures over 100 degrees are
retarded 5 degrees
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o Use mouse to select the desired text box and type in the new value

D-3 Boost vs. IGN S.F. ™

Eoozt ws ISM SF.

Eoozt SF

FA36 1.0
3840 0.0

o Boost vs. IGN Scale factor

» Scale factor for {D-4 Ignition vs. Air Temp} and {D-2 Ignition vs. Water
Temp}

o Use mouse to select the desired text box and type in the new value

D-4 Ignition vs. Air Temp

L=k vz AirT

Tetnp Retard

|60 4
|50 E
40 [

o Ignition vs. Air Temp
» Ignition is retarded if Air temp is too high
e For the standard setting: at 40 degrees C or less ignition timing is
not corrected. From 40 ~ 50 timing is additionally retarded to a max
of 2 degrees. From 50 ~ 60 timing is additionally retarded to a max

of 4 degrees. All temperatures over 60 degrees are also retarded 4
degrees

o Use mouse to select the desired text box and type in the new value

D-5 Ignition vs. TPS

TGN vs TPS
TPS%

ToT 1.000
595 1.000
39,5 1.000
199 1.000

o Ignition vs. TPS
» Ignition correction based on throttle position
e Standard Settings = no correction
o Use mouse to select the desired text box and type in the new value

D-6 Ignition vs. Battery Voltage ﬁ
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ISM ws Batt!
0.875 1%
1.000 14
1.313 12
1.524 10%
1797 2
2.094 g

o Ignition vs. Battery Voltage
> Probably increases “dwell angle” if battery voltage is low
o Use mouse to select the desired text box and type in the new value

D-7 Ignition vs. RPM

Adjust R Pty
108 10000

T& 8000
5z 4000
|31 2000
i 1000
lto 480

o Ignition s. RPM
» Adjusts something to do with ignition (dwell?) vs. RPM
o Use mouse to select the desired text box and type in the new value
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E- Settings Fie ﬁ

T T T T T

Bt | e s | e Click for Screen Capture {Settings 5}
o Page five of the setting windows
» The following settings are on “Settings 5” and can be edited and transferred

between FC-Edit and the Power FC
o0 Injectors
Primary Injectors Off (uS) vs BatV
Secondary Injectors Off (uS) vs BatV
Injector Primary > Secondary Transition Overlap
FC-Box Custom Features
o Click the “Settings 5” Tab to bring Page one of the setting windows to the
front

(0]
o
(0]
(0]

E-1 Injectors

Injectors
Mol |100.0 0,00
Mo.2  |100.0 0,00
Mo.3  |100.0 0,00
Mo4  |100.0 0,00
Mo.5  |100.0 0,00
Mo.&  |100.0 0,00

o Injector settings
» Can be used to compensate for true injector flow rates after they have been
flow tested

» Can also be used to give more fuel to a lean piston or take fuel away from a
rich one
o Use mouse to select the desired text box and type in the new value

E-2 Primary Injector lag (uS) vs. BatV ﬁ

Injectors
Mol |100.0 |0.00
Mo.2  |100.0 |0.00
Mo.3  |100.0 |0.00
Mo4  |100.0 |0.00
Mo.5  |100.0 |0.00
Mo.6  |100.0 |0.00

o Primary Injector lag vs. Bat Volts
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» Corrects primary injector lag time vs. battery volts
o Use mouse to select the desired text box and type in the new value

E-3 FC-Box Custom Features

FC Box Custotn Features (Key OFf £ Key On for changes to take effect)

Turer string (8 char)

|_ Enabled [32 IGM Anti Lag Retard
[ Boost Switch (4) .
[ Anti Lag Switch (3) 0.63 IMT Anti Lag

o FC-Box Custom Features

> Enables and input settings for custom features
FC Box Custotn Features (Key OFf £ Key On for changes to take effect)

Turer string (8 char)

M Eincaliza 40 I&M Anti Lag Retard
[ Boost Switch (4) .
[ Anti Lag Switch (3) 1.50 IMT Anti Lag

o Check the enabled check box to activate the FC-Box special features

E-3-1 Anti lag © (AKA Stutter box, Launch box,

Pro start and “"Bang Bang”) ﬁ

o Antilag
» Spools up your turbo for a quick drag launch
e Assuming you will use the standard clutch switch (+ arming switch)
o Cut clutch switch wire
o Connect one end of the wire through an additional (arming) switch from
the standard clutch switch to terminal "SW3” on the FC-Box {FC2 FC-Box 4
Switches}
e The additional switch is used to turn anti lag on and off (arm the
system). Mount this within easy reach of your driving position
o Ground the other end of the clutch switch wire

F& Box Custom Features (key Off /S Key On for changes to take effect)
Tuner string (8 char)

[v Enabled 40 ISH Anti Lag Retard
e vtk L e —
IRLT Anti L
W Anti Lag Switch (3] 1.a0 i ad

o Check the enabled “check box” to enable FC-Box Custom features
o Check the Anti lag Switch (SW3) “check box” to enable Anti lag
o Enter the amount of ignition retard you want in the “IGN Anti lag retard”
text box
e We found 40 degrees (= 40 degrees of retard) to be quite good but
you might want to experiment
o Enter the amount of extra fuel you want in the “INJ Anti lag” text box
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e We found 1.50 (= add 50% more fuel to base map) to be quite good
but you might want to experiment

Push the “Update” button on FC-Edit

Turn the ignition key off and then back on

Arm the system with the additional arming switch

When the clutch is depressed the FC-Box will retard the ignition and add
fuel to the values you have entered in the appropriate text boxes. RPMs
will drop so you need to depress the accelerator to compensate. More
boost will be created

o When the clutch is released the timing and fuel will return to normal
DANGER! Anti lag has a tendency to foul spark plugs

Extra heat will be generated in the exhaust manifold which may
shorten the life of turbos and the exhaust system

Anti lag creates A LOT OF NOISE! And flames out the exhaust ©

O O O O

o

Xo

o

E-3-2 Remote boost switch

FC Box Custotn Features (Key OFf £ Key On for changes to take effect)

Tuner string (8 char)

[ Enabled .3z ISHM Anti Lag Retard

|
[ Anti Lag Switch (3) 0.63 IMT Anti Lag

o Remote boost switch

» Change boost settings “on the fly”
FC Box Custotn Features (Key OFf S Key On for changes to take effect)

Tuher string (3 char)

[v Enabled 40 ISH Anti Lag Retard
v Eoozt Switch (4 )
IMNT Anti L
[~ Anfi Log Switch (3) 1.50 ni tad

o Check the enabled check box to activate the FC-Box special features
o Check the Boost Switch (SW4) “check box” to enable the switch
o You must connect a switch to terminal "SW4"” on the FC-Box {FC2 FC-Box
4 Switches}
o Connect the switch between "SW4” and ground
e When switch is open boost setting one will be selected
e When switch is closed boost setting two will be selected
e Switch will not function if a single turbo boost kit is in use
e If you enable the feature but don’t connect a switch, {A-1 Boost
Control} will be set to Boost setting one

E-3-3 Tuner String 8 characters (read only) N

FC Box Custom Features (Key OFf S Key On for changes to take effect)

Turer string (8 char)

o Power Excel Dealer id
» There is an 8-character string in the Power FC used for tuner details or
something. We have used the string to store the FC-Box custom features data.
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There is a remote chance that a combination of characters used for an Excel

dealer id could be the same as the characters we have use to enable the

custom features

o We suggest you plug in the FC-Box then turn on the ignition (two clicks)
and “"Read All” before starting the engine. Check that a stray string hasn’t
enabled the custom features. If it has, disable it by unchecking the
“enabled” check box and “Update”.

o Set the value of “"IGN Anti lag retard” and “INJ Anti lag” to zero until you
wish to use the function {E-3-1 Anti lag ©}

e When you are ready to use the custom features check the enable box

W-1 “"Read all” the settings and maps and save
the file!

E-4 Notes

Motes

o Notes
» This text box is where you type information you want to save with your
settings
o Just click in the box and type in what you like
e The text will be saved with the other settings and Data
o If you wish to share your settings, you might like to list your mods in
“notes text box”
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F- FC-Box
o FC-Box, the interface between the Power FC and a personal computer (PC).
» The FC-Box is connected to the Power FC via the Commander socket and
connected to a PC via the serial cable (or optional USB converter)
e Connection
» A Power FC sends data to the Commander. The FC-Box is between the Power
FC and the Commander. The F-Box copies that data, translates it and
redirects it down the serial cable to the PC. FC-Datalogit software, FC-Edit is
installed on the PC. FC-Edit software displays the data

> The FC-Box also has some additional features

0, {FC1 FC-Box 4 Additional inputs} Connect up to 4 x 0~5v inputs so you can log
them

o | {EC2 FC-Box 4 Switches} 1 & 2 aren't functional. 3 is the Antilag trigger, 4 remote
boost switch trigger

o \4FC3 Mini din cable} is connected to the Power FC via the Commander socket

» FC-Box
0, Left: Mini din socket for Power FC Commander {FC4 Mini din Socket}. Using the
Commander is optional and doesn't effect FC-Datalogit
o| Right; Serial socket for serial cable to a Laptop {FC5 Serial Socket}
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FC1 FC-Box 4 Additional inputs i

o “AN 0-5V in”
» Info on logging additional inputs
e See {1-2-1-3 Auxiliary AD Zone}
e {1-3-2 Auxiliary (Setup)} t up scale and values for A/d

N\

FC2 FC-Box 4 Switches

o “SW 0V in/out”
» SW1; Switch one unused
» SW2; Switch two unused
» SW3; Switch three anti lag trigger
e The standard clutch switch with an additional series switch to ground
is required
e See {E-3-1 Anti lag ©} for additional settings
» SW4; Switch four is boost select switch
{E-3-2 Remote boost switch}
Connect the switch between SW 4 and ground
When switch is open boost setting one will be selected
When switch is closed boost setting two will be selected
Switch will not function if a single turbo boost kit is in use

FC3 Mini din cable ™

o Mini din cable
» Connect “Mini din cable” to Power FC’'s Commander socket to allow FC-

Datalogit to communicate with Power FC
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FC4 Mini din Socket ﬁ

0 Min din Socket
o Plug Power FC commander into “Min din Socket” so commander will
function
e A Power FC Commander will pause while FC-Edit or FC-Datalogit is
communicating with the Power FC.

e A Power FC Commander doesn’t update while you are data logging.

FC5 Serial Socket

o Serial socket
» For serial cable to connect to a Laptop

Datalogit FC-Box; Connection
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/\
N- Notes

N-1 Knock Value is Arbitrary »

Sensor is just a microphone and picks up a range of frequencies.
Values under 60 are considered “Safe”. Small values are desirable :)
{W-5 Check Engine Light Flashing Quickly! Knock Warning}

Knock Warning can be switched off, see; {A-3-3 Knock Warn}

Or Thresh hold adjusted, see; {A-5 Knock Warning}

o Yo Yo (]

N-2 Boost Control Kit for single turbo »

e Switch on {A-3-1 Boost Control Kit}

e Only setting group "1” from {A-1 Boost Control} is used. {E-3-2
Remote boost switch} switch is disabled

e If you are using a single turbo and are relying on the pressure of a
waste gate spring to control boost, make sure you set the boost in
setting group “1” from {A-1 Boost Control} to a value higher than
the waste gate spring allows, so you don’t hit the Power FC Over
Boost Fuel Cut {W-2 BOOST CUT}

e Apexi single turbo boost control kit for Power FC comes with a 3 bar
Absolute sensor

N-3 Mac Laptop & FC-Datalogit »

FC-Datalogit takes no responsibility for the accuracy of the following installation and
procedure.

Mac installation and procedure was created by Michel

If anyone needs any assistance, feel free to contact Him. rx7tt95@aol.com

Getting Started

1. You'll need a Mac laptop, at the very least 400mhz Powerbook (Bronze
Keyboard, otherwise known as Lombard, or the later Pismo model with built-in
Firewire). Any of the newer I-books (magnesium case, all white) should work
even better. My system configuration is: 400mhz G3, 320mb of ram, and a
6Gig hard drive and a swappable SuperDrive so I can read floppies. Virtual PC
requires at least 192mb to run in OSX, 128mb in 0S9. The Serial to USB
adapter comes with it's own driver, on a 1.44mb floppy. You will have to
either download the disk to a hard drive and transfer it somehow, or purchase
your own adapter that utilizes a more modern disk to store the driver
on. Most Wintel-based PC's still come with a floppy drive.

2. I'd recommend that you have OSX installed (10.1) instead of 0S9.2.

Why? Virtual PC version 5.0 (what I recommend) is much snappier on OSX
and has more functionality. You loose a bit of function when running in
"classic" mode. However, it'll work with both.

3. You'll need Virtual PC 5.0 with either Windows 98 or Win 2000. I recommend
Windows98 as it's less problematic than Win2000 and it's a bit cheaper to
boot. Virtual PC is pre-packaged with either one or several other Windows
packages for that matter.
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4. You will need a serial to USB converter. I'd imagine you could purchase these
at most large computer stores. (The FC-Datalogit optional version requires
either Windows 98 or Windows 2000. See "Third").

5. You will need FC-Datalogit, FC_Edit v1.04, (or later), as it has settings for
Com1-Com4. (Com is short for communications port in Windows 98). For
some reason, Windows 98 assigns Com1 and Com2 to something else (it may
be Virtual PC doing this, or the Mac 0OS). The point being that in v1.03 of
FC_Edit, you only had the choice of Com1 or Com2, which are taken. In v1.04,
there are two additional Com ports, 3 and 4 (Latter versions have settings for
8 Com ports).

Installing Virtual PC on your Mac

After you have all of the above, you'll need to install Virtual PC on your Mac.
Follow the instructions and read the manual first, as there's some new lingo.
I named my virtual pc engine "FC_Edit".

I would recommend that you choose the ‘easy install” option.

Once installed, quit the installer and go through the steps.

There's one section of the set-up where it allows you to choose the "parameters" of
your Virtual PC. Think of it like you're actually setting up preferences on a PC.

In it, it'll allow you to choose how much RAM is allocated to the program. Give it as
much ram you can, as it'll speed things up a bit.

I believe I'm running a 144mb allocation of RAM, per the Virtual PC program.

Install the FC Edit program

After I installed it I then found FC Edit.exe, it looks something like this; C:\Program
Files\FCEdit.exe and dragged it to the Windows Desktop which created an automatic
shortcut so I don't have to go digging for it on the hard drive.

Serial to USB converter installation

For the following, you must do it just as I (and the adapter directions) specify.
Once you have Virtual PC installed and running, shut down Windows 98 and Virtual
PC.

Install the Serial to USB converter in USB port #2 (#1 may work as well).

Once it's hooked up, boot Virtual PC and your "virtual" machine (whatever you
named it), will launch Windows 98.

Once it's up and running, it'll auto detect a new device and search for the
appropriate driver.

The install new hardware program will launch and you should insert the floppy (or
CD), which contains the driver.

Follow the instructions and complete the installation.

Datalogging!

With the car turned off...

Once the driver is installed, and with the converter still plugged into the back of the
computer, connect the serial end to the FC-Datalogit box.

Turn the car on and launch FC_Edit, (which you should have installed already).

It may say "Error opening Com2" or something like that.

Comz2 is the default and it tries that Com first. Click "ok".

You'll have to go under the menu at the top to "Setup" and choose Com3.

Once that's done, try "reading" your PFC.
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If you get an "interface not responding”, try quitting FC_Edit and launching it
again.

If that doesn't work, shut down Windows 98 and restart it with everything plugged
in and the car off.

Once it's fully boots, turn the car on to accessory (engine not running) and launch
FC_Edit again.

If that doesn't work yet again, go down to the USB symbol at the bottom of Virtual
PC and click on it, then USB Settings.

Once the "Settings" window for your Virtual PC pop up, click on USB and make sure
the driver for the Serial to USB adapter is enabled as well as the USB itself.

Once it's enabled, close the window and you should be able to read and write to the
Power FC and to of course, Datalog!
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T-Tips &

T-1 To view the settings in two files
simultaneously

o Open two sessions of FC-Edit

e Opening a session without the interface plugged in (or a second
session, while the interface is already in session) will cause an
“Interface not responding!” prompt, in this case ignore and click OK

e Opening a second session will cause an “Error opening Com1” prompt,
in this case ignore and click OK

e Open one of the files you want to compare in one FC-Edit session and
the other file in the other session

e Use Compare on the first session to find which settings are different,
then switch between the two sessions of FC-Edit (Alt Tab) to view the
different values

e OR size the two session windows so you can see both at the same
time

T-2 How the sample chart was created, Chart
tutorial »

Sample chart
We often get asked, "Why can’t I make my chart look like the sample in the
manual” Well... you should be able to...

First I must point out that there are two elements shown in the picture.
The chart (actually two charts) and 3 map watches (RPM, Speed and Water Temp)
I'll start with the chart.

This is how we did it:

o Charts
> Two charts, one above the other
» The top chart has a grey background and a minimum 0 and a maximum of
100. The bottom has a blue background, a minimum of 0 and a maximum of
250

Lets see how that was done
o To open ‘Setup Chart’ window
o Open the ‘chart’ window
* From the ' window’ drop down menu click ‘Chart’
o Open the ‘Setup Chart’ window
» From the Chart’s ‘Setup’ drop down menu click ‘Chart’
» ‘Setup Chart’ window
e You will see that items along the first row are for setting up the
charts. This is where you select how many charts you want in the
chart window and their format. You can have up to 4 charts
» ‘Charts’
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e This is where you choose how many charts you want on the chart
window
o I chose '2’, so I could have two charts on the same window
» ‘Chart’
e This is where you choose the attributes for each chart
» ‘Chart’ ‘1’
o I left the background grey. I left the minimum value at ‘0’ and changed the
maximum value to ‘100’
» ‘Chart’ ‘2’
o I changed the background to blue. I left the minimum value at ‘0’ and the
maximum value at ‘250’
e Now if you have been following along you should have two charts. I
did have to drag the window a big bigger. Note that if you click and
hold down your left mouse button between the charts you can drag
up and down. Stretching one while squashing the other. Neat!

o Traces
o The traces on chart ‘1’
> RPM (red), Boost (red), Speed (in blue) and Water Temp (also in red)
o The traces on chart ‘2’
» Knock, in red
e If you have been following along you probably need to open a log file
now otherwise you wont see anything on the charts

Lets see how that was done

e From the ‘Chart setup’ Window you will see that the items along the
first row are to do with setting up the charts.

e The items along the second row and ‘Item’ and ‘Caption’ are for
setting up traces you want on plot on the charts.

e You can have up to 20 traces and plot them on any one chart. If you
want the same item on two charts you must create two traces of the
same data and place one on each chart

> Trace ‘1’

o The item I chose was ‘Advanced RPM’. I put trace ‘1’ on chart '1’, colour is
‘red’, min value ‘0’ and max value '‘6000’, ‘Caption” automatically came up
with - RPM’ You can change this if you want

e The max value of ‘6000’ may have confused some people. I have a
max value on chart ‘1’ of ‘100" and a max value of trace ‘1’ of ‘6000,
so at 6000 rpm the trace will be at 100 on the chart. Why didnt I set
the max value of the chart at '‘6000'? Because it wouldn't suit a trace
like water temp, for example... I set the chart at '100’ and think of it
as 100%. Then I set the max values for the traces I want to plot at
about 100% of what I expect them to reach. It makes it easy to see
plots that exceed the max value... they go off the top of the chart!

» Trace ‘2’

o The item I chose was ‘Basic Boost’. I put trace ‘2’ on chart '1’, colour is
‘red’, min value ‘0’ and max value '100’, ‘Caption’ automatically came up
with *- Boost’

» Trace '3’
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o The item I chose was ‘Advanced Speed’. I put trace '3’ on chart '1’, colour
is '‘Blue’, min value ‘0’ and max value '150’, ‘Caption’ automatically came
up with '- Speed’

» Trace ‘4’

o The item I chose was ‘Advanced Knock'. I put trace ‘4’ on chart ‘2’, colour
is ‘Red’, min value ‘0’ and max value ‘250’ (Because I forgot to set it to
100), ‘Caption’ automatically came up with ‘- Knock’

e The traces are listed down the right hand side of the chart window in
the order you nhumber them. So if you want to change Knock you
know it’s the 4" one down so it’s Trace ‘4’

» Trace'5’

o The item I chose was ‘Advanced Water Temp’. I put trace ‘5’ on chart '1’,
colour is ‘Red’, min value ‘0" and max value ‘250’ (Because I forgot to set it
to 100), ‘Caption’ automatically came up with *- WtrT’

e Scrolling. There are two little white scrolling tags down the bottom of
the bottom chart. The numbers down the bottom are seconds. If you
drag the tags closer together ‘time’ will be stretched out. If you right
click on the chart you can drag along the time axis. I dragged the
right tag to the extreme right of the charts to the end and I dragged
the left tag to150 seconds

e Now you should have the same chart set-up as the sample. It is just
a sample you should set it up to display what ever you want to view...

o The Watches in the sample
» Watch ‘1’ RPM, Big and bold!
» Watch ‘2’ Speed, red...
» Watch ‘3’ Water temp

Lets see how that was done
o Open the ‘Setup Watch’ window
* From the ' window’ drop down menu click ‘Add Watch’ ‘Setup Watch’
window
e The '‘Setup Watch’ window is where you choose the attributes of a
watch. You can return and create more watches or edit the attributes
of your watches by double clicking on an existing watch face or by
choosing ‘Add Watch’ from the ‘Window’ drop down menu
» Watch ‘1’ RPM, Big and bold!

o From the Setup Watch window ‘Watch’ 1. Watch 1. ‘Item’ I chose
‘Advanced RPM’. *Caption” Rpm. ‘Font’, Click the ‘Font’ button and you can
select font type, style, Size, then click OK, I chose; ‘Comic Sans MS’
‘Regular’ ' Size 36'.

» Watch ‘2’ Speed, red...

o From the Setup Watch window ‘Watch’ 2. Watch 2. ‘Item’ I chose
‘Advanced Speed’. ‘Caption’ Speed. ‘Font’, I left standard.
= I wanted the Watch text to change colour at 100 km/h (The open road

speed limit here in New Zealand), ‘Colours’ I chose ‘2’, Colour ‘1’ I left

black but I changed the ‘Max Val(ue)’ to '100’, Colour ‘2" I changed to

‘red’, The result is at 100 km/h or over the text changes to red.

e There is also a ‘Decimal Places’ drop down menu this selects how
many decimal places are displayed on the watch
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» Watch ‘3" Water temp.
o I chose ‘Advanced Water temp’ and left everything standard
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W- WARNING! N

¢ Some of these warnings may not be applicable to your vehicle

W-1 “Read all” ™

¢« We suggest you “Read all” the settings and maps and save the file
before you start editing

¢ “Read all” the settings before you enable the FC-Box special features.

¢ See {E-3-3 Tuner String} for a special message

W-2 BOOST cuT ™

¢ Fuel cut will occur if boost reaches 0.25 Bar above the Boost value
set in {A-1 Boost Control}

W-3 Exhaust Temp Light flashing! N

¢ If you exceed the factory Map / pressure sensor the Check engine
light will flash.

W-4 Check Engine Light Flashing slowly! Injector
Duty / Map Warning ﬁ

« If Injector on time is over 98% or the Map sensor is over 5V,
¢ Check Engine Light will flash in 0.5 sec intervals.
= Injector Warning can be switched off, see; {A-3-2 Injector Warning}

W-5 Check Engine Light Flashing Quickly! Knock
- /\
Warning ~*
+ If Detonation is over “60"” Check Engine Light will Flash in 0.1 sec
intervals three times
Knock Warning can be switched off, see; {A-3-3 Knock Warn}
Or Thresh hold adjusted, see; {A-5 Knock Warning}
{N-1 Knock Value}

r— Yo ¥o
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Z-FC-Edit Screen Captures

I Pages contain standard Power FC data, which may or may not be
applicable to your vehicle

o Cover Page

> FC-Edit
o Maps

> INJ Map

» IGN Map

> VVT Map

> Base Map
o Settings

> Settings 1

» Settings 2

» Settings 3

> Settings 4

» Settings 5
o Monitor

> Monitor Window
o Chart
> FC-Datalogit Chart window
> Sample chart
o Graph windows “3D View”
IN]
IGN
IGT
VT

YVVVVYY

> Set-up Watch

» Set-up Chart

» Set-up Aux

» Set-up Polynomial
o Map watch

Map watch
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2 FC-Edit 277GE - default. dat Mi=1E3

File ‘Window Tools Setup

INTihap | I&Map | wiTaap | Basemap | Seftingst | Settings 2 | Settings 3 | Settings 4 | Settings5 | IFe-Edit!

Beta FC-Edit 2Z7-GE v1.081 F C_ D atE

FC-Edit Software is to be used in
conjunction with a Power FC and requires
an "FC-Box" interface.

. Thisversion of FC-Edit is for 1ZZ-FE. | “|
For more information, and the evolving £

manual, go to
http://groups.yahoo.com/group/datalogit
E-Mail 2ZZE6E@rx7 net.nz

YWe have taken great care to ensure that our products are as safe as possible..BUT, please
take extreme care when using this product. Inputting incorrect data into a POWER FC can
damage your engine. If you hve any doubts about this product or your ability to use it please
DO NOT use this product.

Read All Write All [ MapTracer
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2 FC-Edit 277GE - default. dat Mi=1E3

File ‘Window Tools Setup

INT Map | I&Mthop | WThiap | Baseiop | Settings 1 | Settings 2 | Seftings 3 | Settings 4 | Settings5 |  Fe-Edit

NO1 W02 [NOo3 [No4 [WoS [Nog [NO7 [Mog [N03 N10 [W11 [N12 TH13 [W14 [N15 [N16 [M17 [N18 [M19 [Nz0
PO1_[1.000 1.0001.000 1.000/1.000 1.000/1.000 1.0001.000 1.0001.000 1.0001.020 1.020 1.020 1.027 1.027 1.027 1.027 1.027
P02 [1.000 1.0001.000 1.000/1.000 1.0001.000 1.000/1.000 1.0001.000 1.000 1.020 1.020 1.020 1.027 1.027 1.027 1.027 1.027
P03 [1.000 1.0001.000 1.0001.000 1.0001.000 1.000/1.000 1.0001.000 1.000 1.020 1.020 1.020 1.027 1.027 1.027 1.027 1.027

P04 |1.000 1.000 1.000 1.000:7.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.020 1.020 1.020 1.027 1.027 1.027 1.027 1.027
P05 |1.000 1.000 1.000)1.0001.000)1.000) 1.000|1.000) 1.000|1.0007 1.000|1.000 1.020{1.020 1.020/1.027 1.039/1.0331.039/1.033
POG | 1.000 1.000 1.000)1.000 1.000/1.000) 1.000|1.000) 1.000|1.0007 1.000|1.000 1.020{1.020 1.020/1.027 1.039|1.033 1.055| 1.055
PO7 |1.000 1.000 1.000|1.000 1.000]1.000) 1.000]1.000) 1.000|1.000 1.020/1.020 1.033/1.035 1.033|1.055 1.0589| 1.053 1.074/1.074
P02 |1.000 1.000 1.000)1.0001.000/1.000) 1.000]1.000 1.000|1.000 1.031|1.047 1.047|1.055 1.083|1.074 1.074|1.074 1.082|1.082
P03 |1.000 1.000 1.000)1.000 1.000]1.000) 1.000]1.000 1.000/1.035/1.090/ 1102 1.113/ 1113 1.129/1.125 1126/ 1.125 1.126/1.125
P10 |1.000 1.000 1.000)1.000 1.000)1.000 1.000)1.012) 1.023/1.055 1.1171.145 1156 1.156 1.156| 1.156/ 1.164| 1.164 1.164|1.164
P11 |1.004 1.004 1.004|1.004 1.004|1.023 1.023|1.043 1.085/1.090 1.1371.180 1.180/1.180 1.180/1.180 1.180/1.180 1.120/1.180
P12 11.020 1.0201.020/1.020/ 1.020/1.027 1.085| 1.055 1.063|1.098 1.145/1.184 1.184/1.154 1.184/1.184/1.184/1.199 1.193/1.193
P13 11.031 1.0311.031/1.0311.031/1.055 1.074/1.074 1.082/1.109 1.156/1.184 1.184/1.184 1.184/1.184 1.191|1.203 1.203/1.203
P14 11.031 1.031 1.031/1.0311.031/1.055 1.074/1.074 1.082/1.109 1.156/1.184 1.184/1.184 1.184/ 1191 1.191|1.203 1.215/1.215
P15 |1.031 1.031 1.031/1.0311.031/1.055 1.074/1.074 1.082/1.117 1.156/1.154 1.184/1.154 1.184/1.191 1.191|1.203 1.215/1.215
P16 |1.031 1.0311.031/1.031/1.031/1.055 1.074|1.074 1.082/1.117 1.166/ 1154/ 1.184/1.154 1.184/1.191 1.191|1.203 1.215/1.215
P17 11.031 1.0311.037/1.0311.037/1.055/1.074) 1.074 1.082/1.117 1,156/ 1184 1.184/1.184 1.184/ 1131 1.191)1.203 1.215/1.215
P18 |1.031 1.031 1.031/1.0311.031/1.055 1.074| 1.074 1.082/ 1117 1.156/ 1184 1.184/1.184 1.184/ 1131 1.191)1.203 1.215/1.215
P13 |1.031 1.031 1.031/1.0311.031/1.055 1.074/ 1.074 1.082/ 1117 1.156/1.184 1.184/1.184 1.184/ 1131 1.191)1.203 1.215/1.215
P20 |1.031 1.0311.031/1.031/1.031/1.055 1.074/1.074 1.082/1.117 1.156/1.154 1.184/1.184 1.184/ 1131 1.191/1.203 1.215/1.215

Read ‘ Write ‘

Read All ‘ Write All ‘ [ MapTracer
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% FC-Edit 2ZZGE - default. dat

File ‘Window Tools Setup
INTihop | oM Mapi | WiTiap | Basetap | Seftings t | Settings 2 | Settings 3 | Settings 4 | Settings5 |  Fe-Edit
NO1 W02 [NOo3 [No4 [WoS [Nog [NO7 [Mog [N03 N10 [W11 [N12 TH13 [W14 [N15 [N16 [M17 [N18 [M19 [Nz0
FO1 |24 24 25 |25 |26 |28 |32 (36 (33 (40 (40 (40 40 (40 (40 (40 (40 40 (40 |40
FOZ |24 24 25 (25 (26 28 |32 36 33 40 40 33033 383 3@ 3@ 3% 3 3@
PO3 |23 24 25 (25 (26 28 |32 35 033 40 40 33 3@ 3 IO/ OB
FO4 |22 23 24 2 (25 28 |32 3 3 3@ 3@ W W ¥k 3/ O3/ O/ O/ O/
POS |20 22 23 |23 24 26 |29 32 33 34 34 34 3 333 333333 3 oom
POG |16 20 22 (22 (22 |24 |26 28 29 29 3 ;0 0 AN A F 7 ;o3
PO7 |11 18 17 18 |20 (22 |24 27 27 27 |27 |2 27 27 33 (300 30 20 A0
POZ |6 2 11 14 (17 |20 |22 X (X% |28 |25 |24 X% 24 29 29 |29 2 28 28
PO |5 B & 11 18 18 |21 23 2 24 24 |23 M (23 28 29 |2 X% 2% 27
PO |4 & & & 13 (18 19 M 23 23 (22 |22 2 (23 2 24 |7 ™ X%\
P11 |2 4 & 7 12 14 17 20 2323 22 2@ 2 2327 M7 M X%/
P2 |2 4 5 7 10 (12 |18 19 (22 |22 22 |22 2 23 0% 2|7 M %™
P2 |2 4 &5 7 10 (12 (18 19 M |22 22 |22 2 230/ 2|7 M X%/
P14 |2 4 &5 7 10 (12 (18 19 M 22 22 |22 2 (23 /2|7 M X%/ %
PI5 |2 4 & 7 10 (12 (18 19 A (22 (22 |22 23 /MM @7 M »m &
PIE |2 4 & (7 10 (12 (18 19 A (22 (22 |2 2 23 /MM @7 M 0w\ &
P7 |2 4 5 7 10 12 15 1921 22 (22 @R R 23 &\ ™ &7 Mm%
F1g |3 4 5 7 10 12 15 13 A 22 (22 @22 0:\ M |7 M XS 5%
F19 |3 4 5 7 10 12 15 13 A 22 (22 @22 0:\ M &7 M XS 5%
F20 |3 4 5 7 10 (12 |15 19 A (22 (22 |22 2223282 |27 M X%
Read ‘ Whrite ‘
Reﬂd AII ‘ Wr‘ife ﬁ” ‘ B MapTracer
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2% FC-Edit 2ZZGE - default. dat
File ‘Window Tools Setup

INThap | I&Mkap | WVT Mapi | Bose tap | Seftings t | Settings 2 | Settings 3 | Settings 4 | Settings5 |  Fc-Edit

NO1 W02 [NOo3 [No4 [WoS [Nog [NO7 [Mog [N03 N10 [W11 [N12 TH13 [W14 [N15 [N16 [M17 [N18 [M19 [Nz0
POl |50 50 50 50 &0 50 &0 50 &0 50 &0 50 &0 50 &0 50 &0 50 &0 &0
P02 |50 50 50 50 &0 50 &0 50 (&0 50 &0 50 &0 50 (&0 50 (&0 |50 &0 |50
P03 (50 50 50 50 &0 50 &0 50 &0 50 &0 50 &0 50 (&0 (50 (&0 |50 &0 |50
P04 |50 50 50 50 &0 50 &0 50 (&0 50 &0 50 &0 50 (&0 50 (&0 |50 &0 |50
POS (50 50 (50 44 (45 44 45 45 47 45 46 47 47 47 47 47 47 48 48 4B
PO (50 50 48 35 (35 37 37 33 42 40 M1 44 43 41 43 42 46 47 47 47
PO7 |50 50 45 32 30 30 A 3 I/ 3 I7 37 I 3 35 36 43 (45 45 45
P02 |50 50 42 31 (25 28 29 34 32 32 32 3/ 33330332 443 43 43
P03 (50 50 40 30 20 25 26 31 30 30 30 30 30 30 25 26 37 40 40 41
PI0 |50 50 37 30 14 19 24 30 23 22 2% 30 M 30 2% 2% 32 3/ WK 38
P11 |50 60 3 29 14 18 24 27 20 22 2% 30 3 30 2% 2% 27 24 M 3
P12 |50 50 3 28 13 17 21 24 20 20 24 28 2@ 28 2% (2% 27 24 M 3*
P12 |50 50 3 25 13 16 19 21 19 19 22 2% 2% 26 2% (26 27 24 M 3
P14 [50 50 3 25 13 16 18 20 18 18 20 24 2 24 2% 2% 27 24 M 3
P15 [50 50 3 25 13 16 18 20 18 18 20 24 24 24 2% (26 27 24 30 36
PIG |50 50 3 25 13 16 18 20 18 18 20 24 24 24 2% (26 27 24 30 36
P17 |50 50 3 25 13 16 18 20 18 18 20 24 24 24 2% 26 27 24 3 3
P13 (50 50 3 25 (13 16 18 20 18 18 20 24 24 24 2% (26 27 |24 3 3
P19 (50 50 3 25 (13 16 18 20 18 18 20 24 24 24 2% (26 27 |24 3 3
P20 |50 50 36 25 (13 16 18 20 18 18 20 24 24 24 25 26 27 |24 30 36

Read ‘ Write ‘

Read All ‘ Write All ‘ [ MapTracer
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2 FC-Edit 277GE - default. dat Mi=1E3

File ‘Window Tools Setup

INThap | I&Mdap | wiTmaop | Base Map! | Seftings t | Settings 2 | Settings 3 | Settings 4 | Settings5 |  Fc-Edit

NO1 W02 [NOo3 [No4 [WoS [Nog [NO7 [Mog [N03 N10 [W11 [N12 TH13 [W14 [N15 [N16 [M17 [N18 [M19 [Nz0
P01 | 0.392 0.300 0.348 0.342 0,343 0.402 0,472 0.444 0443 0.440 0,420 0.416 0.416 0.416 0.416 0.416 0.416 0.416 0.416 0416
P02 |0.788 0.760 0.700 0.700 0.700 0.820 0.948 0.882 0.896 0.880 0.840 0.836 0.836 0.836 0.836 0.836 0.836 0.836 0.836 0.836
P03 [1.520 1.522 1.760 1.692 2.048 1.880 1.980 1.8401.760 1.720 1.672 1.672 1.672 1.672 1672 1.672 1672 1.672 1672 1672
PO4 | 2448 2462 2,996 2892 2.884 2762 2640 2592 2572 2548 2500 2500 2500 2500 2500 2500 2500 2500 2500 2500
P05 |3.792 2702 2.804 2752 2560 3496 3.460 3512 3.384 3396 2.400 3400 3.400 3400 3.400 3.400 3.400 3.400 3.400 3.400
POG |4.772 4642 4983 4560 4.400 4.428 4384 4300 4.376 4364 4.200 4484 4420 4536 4420 4640 4,428 4492 4384 4443
P07 |5.528 5552 5.704 5.356 5.356 5.362 5.280 5.304 5300 5.216 5324 5476 5476 5564 5456 5609 5388 5508 5.456 5368
PDZ | 6968 £.956 £.944 £.360 6312 £.282 £.332 £.332 £.172 6176 £.212 £.196 6128 6.256 G172 6.364 G172 6402 £.412 6152
P03 |7.756 7.900 7.676 7.304 7.088 7.002 7.048 6.992 6£.996 £.972 6.812 6812 £.748 £.709 .864 6.576 6.816 G.964 £.840 6456
P10 |2.932 9164 2.864 8.320 7.800 7.836 7.916 8.096 2.208 8.152 7.824 7.720 7.620 7.676 7.736 7.744 7.724 7516 7404 7.236
P11 |9.852 1012 9.636 9.224 9.012 9140 9.220 9132 9.140 9.056 2776 8.700 8712 8672 8752 B.840 8336 8164 2192 8100
P12 [10.89 11.22 10,70 10.21 10.06 10.25 10.32 10.31 1018 10,14 9.928 9.756 9.996 10.27 10.16 1015 9.328 9.392 9156 9.156
P13 1208 1204 11.48 11.02 11.05 11.20 1116 11.22 11.01 10.96 10.97 10.86 10.95 11.04 11.21 11.30 1059 10.64 10.37 10.16
P14 13208 1256 1210 11.79 11.83 11.80 11.89 11.92 11.86 11.94 12.04 11.87 12.04 1212 1218 12.25 11.73 11.49 11.33 11.25
P15 [1390 1339 1278 1254 12.43 1265 1264 1264 1292 1317 13.29 1215 13.04 13.22 1346 13.48 12.87 1264 1255 12.46
P16 [1390 1339 1278 1254 12.43 1255 1264 1264 1292 1317 13.29 1215 13.04 13.22 1346 13.48 12.87 12.64 1255 12.46
P17 (1350 1339 1278 1254 12.43 1255 1264 1264 1292 1217 13.29 1215 13.04 12.22 1346 12.48 12.87 1264 1255 12.4k
P18 (1390 13391278 1254 1243 1255 1264 1264 1292 1217 13.29 1215 13.04 12.22 1346 1248 12.87 1264 1255 12.46
P19 (1390 13391278 1254 1243 1255 1264 1264 1292 1217 13.29 1215 13.04 12.22 1346 1249 12.87 1264 1255 12.46
P20 1390 1339 1278 1254 1243 1255 1264 1264 1292 1217 13.29 1215 13.04 12.22 1346 1248 1287 1264 1255 12.46

Read ‘ Write ‘

Read All ‘ Write All ‘ [ MapTracer
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% FC-Edit 2ZZGE - default. dat

File ‘Window Tools Setup
INThap | I&Mdkap | WiTaap | Base tap | iSettings 1| Settings 2 | Settings 3 | Settings 4 | Settings5 |  Fc-Edit
Boost Control Rey / Idle
Boost Duty Rew Limit |g300
v 1.
nao |24 | FCAE [som0
iz
Loo  Jas | FFCE/L [5e00
i 3
110 50 ! Fic ‘e [11o0
4, Protect
|1'2E' |56 | Idle A.E 1300 retes
[ Ign Map
Idle EAL )
Function Select = 800 [ Inj sap
- Idle A/ |zs0 [ PTa Yalt
1.Boost cntl kit - [ Injectar
ZInj/AirE Wam. [ Krnock wiarn 02 Feedback B G
_ [ Accelerate
3.knock Warning [ [ Ian/In
l4.02 F/B Cantral [ &0 Thresk [ Cranking
) ) [ witr Temp
5 Idle-I& crtrl v 9 Setting 1047 Sefting ™ Rew/Idle
Werzion
Program String | 227-GE
Program Werzion |2 714
Read All Write All [ MapTracer
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% FC-Edit 2ZZGE - default. dat

EBX

File ‘Window Tools Setup
INTihap | I&Map | wiTaap | Basetap | Seftings t | Settings 2] Settings 3 | Settings 4 | Settings5 |  Fc-Edit
Virater Temp Correction Accelerate Injector (n3) Cranking {m3) Inj vs Accel TPS1
+50C  |1.000 1.000 RPAA Amount  Decay +50C |75 Input Setting
5000 4400  |0.500 128 230
+30C |1.047 1.075 | | ! +50C [10.0
4000 4.100 0.800 50 179
+30C |1.0%4 1141 | | ! +30C [16.0
3000 3.800 |0700 16 102
+0C 1188 1.297 | | ! 02 [ze0
2000 3500  |0.600
1ac |1.591 1554 | | | -108 |55.0
1000 3.z00  |0.500
30C |1.594 1.691 | | | -30C 110
IMNIws TPS Inj ws AirTemp
TP5%: Setting
89.8 1125 +80C  [0.038
500
7T 1125 * 0369 IMI vs Air Temp and Boost (max)
300
673 1125 ¥ 1000 Tetnp Setting Boost INT vs wWiater Temp and Boost (max)
100
59,3 1078 + [1.0z0 ED 11000 [7936 Temp Sefting  Boost
50.0 1.03% -10C 1039 |70 11.000 [100 [1.078 [79386
59.8 1.000 -30C  |1.059 a0 11.000 600 |70 [1.000 |3540
Reﬂd AII Wr‘ife ﬁ” B MapTracer
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% FC-Edit 2ZZGE - default. dat

File ‘Window Tools Setup
INThap | I&Map | wiTahap | Basemap | Seftingst | Settings 2 | isettings 3| Settings 4 | Settings5 |  Fc-Edit
Map Reference Afr Flow
Boost R.Pan
01 [500 w00 1 |122Z-5E 0644 |1o0.0
1.28% looo
0z |10o0 500 " 2 |z.0ption 1 L I1unn
03 [zooo 1200 '
7 3 |3.0ption 2 256 1000
04 [3000 1600 3200 |100.0
05 [4000 2000 £ 4 |4 0ption 3 B hunh
0é [5000 2400 '
" 5 | 5.0ption 4 4.48Y 1000
o7 [s000 2800 5121 1000
08 [Fooo 3200 '
09 [s000 3600
10 |2000 4000
11 |10000 |4400
12 |11000 4800
13 [12000 5200
14 [13000 5600
15 [14000 £000
16 [15000 400
17 [1s000 800
1a [1yooo  [Fzoo
19 [18000 [Fs00
20 |19000 s000
Read All Write All [ MapTracer
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% FC-Edit 2ZZGE - default. dat

File ‘Window Tools Setup
INThap | I&Mkap | WiTahap | Basetap | Seftingst | Settings 2 | Settings 3 | Settings 4| Settings5 |  Fc-Edit
ISM vs WaterT Coal ISM ws Bath ISM vz RPAG
Temp Retard Adjust RPA,
0.875 1ah 1as 10000
-50 &
1.000 144 T & gooo
Rats 13
1.515 12 52 4000
ISH ws WiaterT Boost vs IGM S.F. 1594 10y 51 2000
Temp Retard Boost SF. 1797 oy 17 1000
100 5 TO3E 1.0 — oy B 480
20 0 3840 0.0
ISM ws AirT ISH ws TRS
Termp Retard TP5%
&0 4 FoF 1.000
a0 2 59.8 1.000
40 0 39.8 1.000
19.9 1.000
Read All Write All Update ™ MapTracer
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2% FC-Edit 2ZZGE - default. dat
File ‘Window Tools Setup

INThap | I&Map | wiTmap | Basemap | Seftingst | Settings 2 | Settings 3 | Settings 4 | isettings 5|  Fc-Edit

Injectars IMT Pr Lag (u3) vs Bafy
Mol fiono fooo lDasz 16
Moz fiooo fooo D66 14
Moz fioo0 |ooo lo.psz 12w
a4 oo W W 10%
MoS 1000 W W gy
Mg [1o0.0 0.00 |z508 &V

FC Box Custom Features (Key Off /£ Key On for changes to take effect) Motes

Tungr string (8 char)

[~ Enabled _g= ISM Anti Lag Retard
Eoost Switch (4
I (F1057 L) () 063 INTAnti Lag

[ Anti Lag Switch (3)

Read All Write All Update I mapTracer
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2 Monitor E@

Questions? Manual@fc-datalogit.co.nz

Bazic m Senzors Alxi I-:u'*;-r AD
ulk
Inj Duty F ISM F RN WTA AN1
STR [ MERL
Ian Trng ~ oswl Fre WTRT AMZ
Air Flow F PWSF WS AIRT E:
AL ACR
[ | Enarev FEICe O | AN4
i T RL | FaANM Map Ref
Boost ELD ™ p
Krock Afc l_ l_
T wtr Temp Y ;m;:;g;
l— l— Air Temp [w Sensors
[w A= ASD
Eat wolt W iap Ref
[v Advanced
Advanced li':' i
Fpm IGH k.nock, e
[ PM [ Dwel [ Baty [ ¥ Reset
AFLY Boost Speed Start
VTAY Duty 777 —
IMJ s wiiT 0251 End
(M) +/- &irT o252 Save
/\
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E% FC-Datalogit - Untitled. bt M(=]t3

File Log ‘window Setup

25|:| 1 1 1

200

150

100

50
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< FC-Datalogit - Log 023010_2004. txt
File Log ‘Window Setup

] WtrTemp x

118 || 95

Rpm

» A sample of a set-up chart with watches and an open log

N\
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2 3D View =3
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B2 3D View =3
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22 3D View

COX
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2 3D View =3
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22 3D View
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ESEtup Watch E][E
Weatch | 1. Rpin j
Ttem |Basic Rpm =

Captian rprm

Fant... | 48pt Comic Sans M5

Colours  Calour M Wal Backdaolour

Cecitmal Places IEI

aK Cancel ‘

\
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Questions? Manual@fc-datalogit.co.nz

ﬁSetup Chart BE]

Charts  chart Back<olour Min Yal A Val
E - 1 - 0 120

Trace  chart Caolour Min Yal M Yal

Ttem | Eosic Rpm j
Caption |- Rpm
Lone ‘ Apply
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ﬁMap WWatch
File Log Yiew ‘Window Options

|ﬂ.|:|v-:lnced Knock

~[wax

-

|10

Hold off (inSec) (120

M val

Questions? Manual@fc-datalogit.co.nz

NOT |MOZ2 |N03 W04 |NOS [ MOE |MO7 |NOS N0 [N10 [N1T [N12 [M13 [N14 |N16 |N1E [ W17 |N18 |N13 |N20
P
P02 22 32 1M 1 1w 8 7
P03 22 25 33 42 34 14 3 7 12 4 2
P4 314 18 34 43 44 45 15 37 14
P05 Oi 9 18 31 329 59 B0 57 34 25
P& 17 10 16 14 46 E8 54 EE 31 45 3
P07 4 B 17 23 43 B9 B8 E3 3 28
FO3 1 B 13 M 44 8B4 72 E5 E7 7R
P03 o 4 31 37 B2 ER 70 47 73 92 34
P10 11 44 43 41 BE &2 102 97
P11 31 43 B0 B0 B0 B0 A0 E9
P12 E2 33 &3 EBE 86 101 104 35
P13 54 E3 EF E2 G0 93 13
P14 B4 43 72 78 595 89 19
P15 B 43 91 70 B3 EE 7R
P16 52 B4 B4 102 956 74 A
P17 53 85 104 22
P13 43 E7 B4 B3 72
P13 41 72 105 20
P20l B 25 875§

/\
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o Setup Auxilanys

EOX

ARl AlZ

Marme  wide Band Marme | pawe

Wolts Walue nit Woltz Walue it

o 110 |AFF [ [ |1

5 70 Poly 5 5 Poly

ARG Alld

Fame  |paw Mame  |pawe

Woltz Walue nit Woltz Walue it

0 0 i 0 0 i

5 5 Paly 5 5 Paly
[ Delta AMI-ANZ
[ Delta ANS-AR4 oK s
[ ReCalculate Log

/\
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= Setup Polynomial g@

yzax"2+bx+c

n oo

11

Cancel
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